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End User License Agreement 
This is a legal agreement between you, the end user, and Gaumard

®
 Scientific Company, Inc. 

(“Gaumard”). This software is protected by copyright laws and remains the sole property of 
Gaumard. By installing the GIGA (the "Software") media, you agree to be bound by the terms of 
this agreement. If you do not agree to the terms of this agreement, promptly return the uninstalled 
media and accompanying items to Gaumard at the address indicated below. 

1. Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install 

and activate the Software on one computer for use with one Interactive patient simulator system. 
The software may also be installed on any number of other computers at the same institution so 
that students may access the learning resources. One copy of the software may be made for 
backup purposes. You may not network this Software, or allow multiple users unless you 
purchased a multi-user workstation license. Sharing this Software with other individuals or allowing 
other individuals to view the contents of this Software is in violation of this license. 

2. Copyright. The Software is owned by Gaumard and protected by United States copyright laws 

and international treaty provisions. Therefore, you must treat this Software like any other 
copyrighted material. You may not make this Software or copies thereof available in any manner or 
form or use, copy or transfer the Software, in whole or in part, except as provided herein. 

3. Other Restrictions. You may not rent or lease this Software to any other party. You may not alter, 

merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the 
contents of this Software to any other party. 

4. Electronic Transmission of Software. If you received the Software by electronic transmission or 

by Internet delivery, by installation of the Software, you acknowledge that you have read and 
understand this license agreement and agree to be bound by its terms and conditions. 

5. Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto 

shall commence upon installation of this Software. This Agreement and the license granted herein 
may otherwise be terminated by Gaumard in the event that you are in breach of any provision of 
this Agreement. In the event of termination, you agree to immediately return this Software, 
accompanying items, and any copies thereof to Gaumard. 

6. LIMITED WARRANTY 

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS 

WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE 

FROM DEFECTS IN MATERIAL AND WORKMANSHIP. ELECTRONIC TRANSMISSION IS 

WARRANTED TO BE FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR 

SOLE AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE 

DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC TRANSMISSION PROVIDED THAT 

YOU NOTIFY GAUMARD IN WRITING OF SUCH DEFECT OR DEFECTIVE TRANSMISSION 

AND RETURN THE DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD. 
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(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE 

SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS" 

BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY 

IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR 

PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS 

DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN 

ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY 

SUCH INFORMATION OR ADVICE. GAUMARD DOES NOT WARRANT, GUARANTEE, OR 

MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF THE 

SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 

RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE RISK AS TO THE 

RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE 

SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS 

DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 

NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY 

DESCRIBED ABOVE. 

(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 

PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, 

INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS 

OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 

AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR 

RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY 

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS 

ARISING OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE 

AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE 

UNDER, IF ANY, EXCEED THE PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE. 

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED 

BY GAUMARD. 

ACKNOWLEDGMENT 

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND 
UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL 
PROPOSED OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED 
HEREIN.
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Care, 
Maintenance, and 
Warnings 
Damage caused by misuse may void the 
manufacturer’s warranty. Failure to 
comply with the following guidelines 
could result in injury or damage to the 
equipment. 

SET UP 

When connecting the battery to the 
simulator, make sure to match the two color-
coded connectors to the corresponding 
color-coded battery terminals. 

Do not use universal AC adapters. Only use 
the AC adapter supplied with the simulator. 

NEVER disconnect the communications 
module while the GIGA software is running. 
The software will halt, and the module may 
be damaged. 

Do not remove the chest skin. Internal 
components are serviced by Gaumard 
certified technicians only. 

Never connect HAL to Ethernet cards, LAN 
networks or unauthorized diagnostic 
equipment. Doing so may cause damage to 
the system.   

Do not connect the RJ45 cable directly to the 
tablet’s Ethernet port. Wired communication 
can only be established using the RF module 
wired port. 

Turn HAL OFF before replacing the battery. 
Failure to do so could result in serious 
damage to the system. 

STORAGE 

Store HAL
®
 in a cool, dry place. Extended 

storage above 85 degrees Fahrenheit (29 
Celsius) will cause the simulator to soften 
and slowly warp. It is acceptable to operate 
HAL

®
 at an ambient temperature of 95 

degrees Fahrenheit (35 Celsius). 

Do not store the simulator with a discharged 
battery. It is good practice to re-charge the 
battery at the end of every simulation 
session. In addition, make sure the battery is 
re-charged at least once every 3 months 
even if the simulator is not being used; 
otherwise permanent loss of capacity might 
occur because of self-discharge.   

PROCEDURES 

Do not intubate without lubricating the airway 
adjunct with silicone oil lubricant (provided). 
Failure to do so will make intubation very 
difficult and is likely to result in damage. 

Do not introduce flammable gases into the 
airway. 

Providers must use an empty syringe when 
simulating drug administration via 
endotracheal tube. Passing liquids into the 
trachea or esophagus may cause internal 
damage. 

Mouth to mouth resuscitation without a 
barrier device is not recommended, as it will 
contaminate the airway. Treat HAL

®
 with the 

same precautions that would be used with a 
real patient. 

Do not turn HAL’s head sideways while 
laryngospasm is on. Doing so may damage 
the mechanism that closes the larynges. 

Always dispose of system batteries in 
compliance with local laws and regulations. 

Do not perform surgical exercises on the 
ventilation insert. 

Only replace trauma limbs when HAL is 
powered off or in standby mode.  

MECHANICAL VENTILATION 

Always follow the mechanical ventilator’s 
guidelines and precautions. 

HAL is not designed to test the performance, 
functionality, and accuracy of a mechanical 
ventilator. 

Do not introduce liquids, humidified gases, 
flammable gases, or administer aerosol 
medications into the airway. Moisture in the 
airway will damage the simulator’s internal 
mechanics. 

HAL’s operating limitations are consistent 
with that of a real human. Treating HAL in a 
manner that would seriously harm a real 
person is likely to result in damage to HAL’s 
internal mechanics.  

Always treat HAL as a real patient. 

IV ARM, DRUG RECOGNITION 
AND NEEDLE DECOMPRESSION 

Only use Gaumard’s provided simulated 
blood. Any other simulated blood containing 
sugar or any additive may cause blockage 
and/or interruption of the vasculature 
system. 
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The use of needles larger than 22 gauge will 
reduce the lifetime of the lower arms' skin 
and veins. 

The simulator must be powered on when 
working with the drug recognition arm. This 
includes calibration, purging, draining, IV 
infusion, Set Med Id and injecting fluids. 
Failure to do so will permanently damage the 
simulator and void the warranty. 

You must always have water in the IV 
vasculature for the drug recognition module 
to work. 

Do not inject fluids into the intramuscular 
sites. 

Do not add liquids to the hemothorax sites. 
Doing so will damage the simulator and void 
the warranty. 

Use only Gaumard’s provided simulated 
blood. Any other simulated blood brand 
containing sugar or any additive may cause 
blockage and/or interruption of the 
vasculature system. 

Maximum amount of fluid injected without 
draining should not exceed 40 mL and the 
maximum injection rate is 9999 mL/hr. 

At the end of every simulation session, you 
must purge the IV system with clean water 
with the simulator powered on. If the drug 
recognition arm is not going to be used for 
long periods of time (a week or more), purge 
the system with 70% isopropyl alcohol 
solution. Failure to do so may permanently 
damage the system. 

CONSUMABLES 

When the arm veins require replacement, 
contact Gaumard to arrange for a lower arm 
exchange. For a small fee, we will deliver 
reconditioned and warrantied lower arm 
assemblies to your facility. After receiving 
the replacement arms, use the same box 
and the enclosed shipping label to return the 
old arms to Gaumard. For international and 
express service, additional fees may be 
charged. Refer to the Consumables and 
Replacement Parts section of this guide, and 
contact customer service for more 
information. 

LATEX WARNING 

Vein tubing contains latex, which may cause 
allergic reactions. Users allergic or sensitive 
to latex should avoid contact. Discontinue 
use of this product and seek medical 
attention if an allergic reaction occurs. 

CO2 CARTRIDGE 

Always follow the manufacturer’s safety and 
warning information included with the CO2 
cartridge package. 

Never point a CO2 cartridge at yourself or 
others 

Do not use damaged CO2 cartridges 

Do not puncture the cartridge CO2 seal 
manually 

Do not expose the CO2 cartridges to high 
temperatures as indicated on the product’s 
packaging 

Install threaded cartridges only (3/8”-24UNF-
2A). Do not attempt to install a cartridge that 
does not meet the specifications listed in this 
document. 

Do not over tighten the cartridge into the 
simulator’s cartridge harness 

Always verify that the CO2 cartridge is empty 
using the software diagnostics before 
removing it. Do not remove the CO2 
cartridge if the simulator is not fully 
operational.  

CLEANING 

HAL should be cleaned with a cloth 
dampened with diluted liquid dishwashing 
soap. If medical adhesives remain on the 
skin, clean with alcohol wipes. DO NOT USE 
“GOO GONE

®
” as the citric acid in the 

formula will cause pitting of the various 
materials comprising your simulator. 

HAL
®
 is "splash-proof" but not water-proof. 

Do not submerge or allow a large volume of 
fluid to enter the interior of the simulator.  

Do not expose the control computer to water 
or excessive dust unless it is protected by a 
rugged case (available separately). 
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Electrical therapy 
 Only deliver electrical therapy when the 

simulator is fully assembled, dry, and 
undamaged. 

 Make sure the defibrillation patches on 
the simulator are in good condition, 
including removing any and all gel 
residue on the defibrillation patches 
from previous use(s). It is a good 
practice to remove gel residues after 
every use. Failure to do so will leave 
behind a film of electrode gel that 
hardens causing arcing and pitting. 

 Do not re-use the gel-adhesive pads. Do 
not leave them on for next day use. 

 Use hard paddles or wet-gel pads 
preferably. Avoid using solid-gel pads 
since they present higher risk of burning 
the simulator’s skin. 

 Gel pads have a shelf life. Make sure 
they are not expired to avoid arcing. 

 Make sure the simulator is not in contact 
with any electrically conductive 
surfaces. 

 Use the simulator only in a well-
ventilated area, free of all flammable 
gases. 

 NEVER attempt to service or modify any 

of the electrical connections, especially 
those between conductive skin sites and 
the internal electronics. Discontinue use 
if any wires are found exposed with 
damaged insulation. 

 Real medical products, especially 
electrodes, sometimes use powerful 
adhesives that can be difficult to 
remove. A gentle, degreasing cleanser 
may be needed. Refer to Care and 
Cautions for more information. 

 Electrode gel on the skin between any 
two electrode targets can become a 
pathway for electrical current, just as in 
real life. If this occurs, HAL's skin can be 
burned. 

 Do not allow defibrillation pads to 
overlap ECG sites. Doing so will may 
damage the simulator and cause arcing. 

 Should dark traces appear on the 
conductive patches due to gel residue or 
previous arcing, use a pencil eraser to 
remove the traces and then clean with 
alcohol.  

DO NOT SCRATCH the conductive patches 

with abrasive objects; doing so will cause 
irreversible damage to the conductive sites 
and subsequently cause arcing 
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Getting Started 
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Equipment setup 

LEG ASSEMBLY 

To install the lower legs: 

1. Remove the fixed bolts from the knee 
joints using the hexagonal wrench 
included. 

 

2. Connect the red pedal pulse lead and 
white CO2 lead to the right lower leg. On 
the left leg, connect the pedal pulse and 
secure the trauma power lead for later 
use. 

 

3. Position the lower legs and insert the 
knee joint bolt. Tuck any extra wire and 
the connector into the lower leg.  

4. Replace the bolt and use the two 
provided hexagonal wrenches to secure 
the knee bolt without over tightening. 

BATTERY 

HAL is shipped with the internal battery 
disconnected. Connect the battery lead as 
part of the first install process. 

WARNING: Do not remove the chest 
skin. 

To connect the internal battery leads: 

1. Locate the connectors on HAL’s right 
hand side. 

 

2. Gently lift the right corner on the chest 
skin as shown and connect the battery 
clip. 

 

3. Slide battery leads inside the cavity. 
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4. Secure the chest skin. Connect the 
simulator’s power charger. 

 

Immediately after connecting the battery 
leads, HAL is on stand-by mode and ready 
to be initialized by the GIGA software. 

BATTERY LIFE 

Battery charge time is approximately four 

hours. The AC adapter’s status indicator light 
displays red when the battery is charging 
and green when the process is complete. 

Feature Runtime 

Internal Battery 5 hours 

To display the battery level, the GIGA 
software must first establish a connection 
with the HAL. For more information about the 
battery indicator, refer to page 12. 

WARNING: Do not store the simulator 
with a discharged battery. It is good 
practice to re-charge the battery at the 
end of every simulation session. In 
addition, re-charged the battery at least 
once every 3 months even if the 
simulator is not being used, otherwise 
permanent loss of capacity might occur 
because of self-discharge. 
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Control Tablet PC 
The tablet PC is preloaded with the GIGA 
control software used by the facilitator to 
initialize the simulator and control the vital 
signs. 

Before turning on the computer for the 
first time, please review the 
documentation included with the 
product for important care and 
warning information. 

USING THE STYLUS 

The tablet’s stylus is a pen-shaped input 
used to interact with files and programs.  

 Left click - tap the screen with the 
pointer. Tap twice rapidly to double-
click. 

 Right click - tap and hold a highlighted 
item or hold the button near the pointer 
and tap the item or text. 

CALIBRATING THE STYLUS 

As part of the initial setup process, calibrate 
the stylus using the Tablet and Pen 
calibration tool in the Windows

®
 control 

panel. Complete the calibration process 
while holding the pen in a natural writing 
position for greater accuracy during normal 
use. 

WIRELESS COMMUNICATION 
USB MODULE 

The controlling computer transmits the 
startup and control commands to simulator 
through the USB RF communication module. 

Connect the RF communication module to 
an available USB port on the tablet. 

 

Secure the RF communication module to the 
tablet or PRO+ computer using the Velcro 
patch. The tablet is now ready to 
communicate with the simulator wirelessly. 
For information about the signal strength 
indicator, go to page 20. 

USB COMMUNICATION MODULE 
WIRED 

The USB communication module is also 
equipped with a wired communication port 
for transmitting the startup and control 
commands to the simulator. The alternate 
wired configuration should be used in 
environments that do not allow wireless 
communications.  

Do not connect the simulator to Ethernet 
cards, LAN networks, or unauthorized 
diagnostic equipment. Doing so may 
cause damage to the system. 

To connect the simulator to the Tablet PC 
using the wired option: 

 Connect the RJ45 cable to the USB 1.
communication module 

 

 Connect the RJ45 cable to the 2.
communication port on the simulator’s 
right side 

 Connect the communication module to 3.
an available USB port on the tablet PC 

 

The tablet is now ready to communicate with 
simulator. 
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STREAMING AUDIO HEADSET 

The computer system includes a headset 
that allows the facilitator to speak as HAL’s 
voice and listen to the participants reply. 

Connect the headset MIC and Speaker 
connectors to the designated ports on the 
side of the tablet PC. Go to page 56 for more 
information about the streaming voice 
feature. 

 

Always connect the streaming audio 
headset before starting the GIGA 
software. 
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Virtual Monitor 
The Gaumard Monitors software displays 
HAL’s simulated vital signs in real time. The 
interactive monitoring software is preloaded 
in to the virtual monitors PC.  

The virtual monitor PC also allows the 
facilitator to play back the session recordings 
stored in the PRO+ PC for debriefing. 

 

VIRTUAL MONITOR PC SETUP 

Refer to the manufacturer’s documentation 
included with the virtual monitor system 
components for important safety, installation, 
and start-up information before turning on 
the PC for the first time. 

To setup the virtual monitor PC: 

 Place the all-in-one PC within line of 1.
sight of the controlling computer 

 Connect the power supply to the PC and 2.
to the wall outlet 

 Connect the USB keyboard and mouse 3.
receiver to the PC 

 Turn on the computer 4.

VIRTUAL MONITOR WIRELESS 
CONNECTIVITY 

The control PC and the all-in-one virtual 
monitor PC establish a wireless link at 
startup automatically. The wireless 
connection allows the Gaumard control 
software to transmit the vital signs 
information to the Gaumard Monitors 
software.  

To verify the wireless link between the two 
computers, click the wireless icon located on 
the task tray. The wireless network name is 
configured at the factory and may differ from 
the one seen below. To troubleshoot 
connection issues between the virtual 
monitor computer and the controlling tablet, 
please go to page 102. 

 

GAUMARD MONITORS 

After the wireless connection is established, 
double click or tap the Gaumard Monitors 
icon to start the vital signs software.  

 

The Gaumard Monitors software is now 
ready to receive the vital signs information 
generated by the GIGA control software. 

 

For more information about the Gaumard 
Monitors software, please refer to the 
Gaumard Monitors user guide. 
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Working with GIGA 
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Initializing the 
Simulator 
After reading the manufacturer’s care and 
caution information, press the power button 
to turn on the Tablet PC. 

 

The GIGA software initializes the simulator. 
Double click the GIGA icon on the tablet’s 
home screen to start.  

 

The simulator selection menu is shown. 
Select HAL and click “Start”. 

 

The wireless link between GIGA and the 
simulator is established within 1 minute. 

PROFILES AND OPERATING 
MODES 

After the startup screen, the profile and 
operating mode selection menu is displayed.  

 

The GIGA control software has two modes of 
operation: Manual and Automatic. Each 
mode includes a Quick Start profile with 
preprogrammed scenarios exercises created 
in conjunction with experienced healthcare 
instructors and working medical 
professionals. Continue to the next section to 
learn more about the each operating mode 
and the profiles included.  

After selecting an operating mode and 
profile, click “Load” to continue. 

MANUAL MODE  

In the “Manual” operating mode, the 
facilitator fully controls the vital signs and 
physiologic responses.  

 

The Manual mode includes the following 
profiles: 

Default Profile – includes one palette with 

healthy vital signs.  

Quick Start HAL – contains ten scenarios  
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AUTOMATIC MODE 

The Automatic mode assists the facilitator by 
automatically adjusting vital signs in 
response to caregiver participation, 
pharmacologic intervention, and manual 
input. For example, when facilitator 
increases the heart rate, the Auto mode will 
calculate the response and adjust the blood 
pressure automatically. To activate the 
operating mode as an upgrade option, go to 
page 98. 

 

The Automatic mode includes the following 
built-in profiles: 

Default Modeling– includes one palette with 

healthy vital signs.  

Meds Profile – This profile contains fifty-two 

pre-programmed drugs to be used on 
simulations. 

Quick Start Hal Modeling – includes eight 

scenarios configured for the Automatic 
operating mode  

CREATING A NEW PROFILE  

Profiles store palette, scenario, and option 
settings independently; changes made to 
one profile have no effect on the others. 
Below are some examples on how profiles 
are used. 

 Assign one profile to each user of your 
Gaumard simulator system 

 Use profiles to organize and protect 
palettes and scenarios 

 Create a profile dedicated to a specific 
academic course taught by multiple 
instructors 

 Devote an entire profile to one particular 
subject area, or even one particular 
scenario 

To create a new profile, click “New Profile”. 

 

Enter a name for the new profile followed by 
a description. 

 

Enable the PIN protection to prevent 
unauthorized users from accessing or 
making changes to this profile. 

Lastly, click “Create” to save the new profile 
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GIGA Interface 
The GIGA software is used control the simulator, monitor the vital signs, and evaluate the 
provider’s performance. The simulation technician or instructor carrying out the simulation operates 
the GIGA software 

The GIGA control elements and scenario programming procedures are consistent throughout the 
Gaumard family of high fidelity simulators. Some software controls and features covered in this 
guide may be hidden depending on the simulator’s hardware configuration and optional upgrades. 

 

Connection status 

The communication indicator displays the status of the radio link between the tablet’s USB RF 
module and the simulator. Full bars indicate excellent communication (i.e., normal operation). 

 

Battery indicator 

The battery indicator displays the battery charge information. An exclamation sign is shown when 
there is no communication with the simulator and battery information cannot be retrieved. 

 

When the battery is depleted, the simulator is set to STAND-BY mode automatically. The simulator 
will not initialize until the power adapter is reconnected. 

Feature Runtime 

Internal Battery Approx. 5  hours 
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Session clock 

The session timer displays the duration of the current session. Click the timer to reset the clock or 
to start a new session. Event entries in the text log are synchronized with the session timer. 

 

Power/Stand-by 

The power button is located at the bottom right corner of the GIGA software. Toggle the power 
button to set the simulator to stand-by mode and then again to resume. 
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Status / Details 
Controls 
The Status/Details panel is used to monitor 
and control the simulator’s vital signs. The 
individual parameter controls displayed on 
the details tab provide the simplest method 
for controlling the simulator’s vital signs, 
sounds, and features. 

There are two viewing modes. The “List 
view” displays the vital signs controls in a list 
format, while the Body view displays the 
interactive patient model with floating control 
boxes. Toggle the view buttons to switch 
between the two modes.  

 

 

 

SYSTEMS LIST VIEW 

In the List View, the vital signs controls are 
divided into separate categories. Click 
through the categories to view the controls 
available for the current simulator 
configuration. 

 

Enable the “instant apply” option and click 
the control to change the vital sign to a new 
value. Vital signs undergoing change blink 
yellow. 
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THE BODY VIEW 

The “Body View” mode displays an 
interactive model of the simulator. The model 
is a representation of the simulator and its 
internal organs. The floating control boxes 
are used to monitor and change the vital 
signs just like in the “List View” mode. 

 

Use the Body View controls to rotate, zoom, 
and re-center the model. Click the 
transparency button to view the model’s 
internal organs. 

 

FLOATING CONTROLS 

The floating controls are used to monitor and 
change the vital signs. The default layout 
displays commonly used vital signs controls. 
Click the + button to add controls to the 
floating window. 

 

Enable the “instant apply” option and click 
the control to change the vital sign to a new 
value. Vital signs undergoing change blink 
yellow. 
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EXPANDED CONTROLS 

The expanded details view is used to 
tabulate a list of vital sign changes before 
applying them all at once. In addition, the 
Details list is used for creating palette items; 
a set of vital signs parameters stored in a 
single loadable item. Click the edit button to 
open the expanded Details list. 

 

The vital signs controls are divided into 
categories. Click through the categories to 
view the controls available for the current 
simulator configuration.  

 

Change vital sign value or state to add it to 
the Details list. 

 

Click the sound controls tab to change the 
sound types for audible features (e.g. heart 
rate) and volume level. 

 

APPLYING CHANGES 

After the list of changes is created, click 
“NOW” to update the vital signs instantly. 
Alternatively, click a trending timer to update 
numerical vital sign parameters (e.g. heart 
rate, blood pressure) gradually.  

 

CREATING PALETTE ITEMS 

A palette item stores one or more vital sign 
settings into a single loadable object. Use a 
palette item to update a set of vital signs 
quickly. For example, one palette item can 
be created to update all the cardiac 
parameters to a healthy state.  

To create a new palette item, set the values 
for the desired vital signs parameters and 
click  
“Save”. 
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Enter a name for the palette, a description, 
and choose color code. Click “Save” to 
create the new palette Item. Palette items 
are stored in the active profile. 

 

When the palette is needed, click the Load 
button to select the palette from the library. 

 

Select the palette item from the “Load 
Palette Item” menu and click “Load” 

 

Click the apply option to submit the changes. 
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AUTOMATIC MODE CONTROLS 

While operating in the Automatic Mode, 
GIGA adjusts the patient’s vital signs 
automatically in response to caregiver 
participation, instructor input, and 
pharmacologic intervention. For example, if 
the heart rate is increased, GIGA will 
calculate a realistic response to the event 
and adjust the blood pressure values 
automatically. To enable the Automatic 
Mode as an option in the profiles menu, go 
to page 98. 

Click “Auto Mode” to pause the automatic 
changes. To return the patient to the initial 
state, click “Reset”. 

 

PATIENT PROFILE 

Patient files store general information such 
as weight, height, and age. The automatic 
mode factors the patient’s weight as it 
adjusts related physiological parameters. 
GIGA includes several preprogrammed 
patients in the Quick Start Modeling profile. 
For more information on the each patient 
profile, go to page 140. 

HAL is the default patient loaded when the 
Quick Start Modeling Profile is selected and 
it is an ideal candidate for most simulations. 
Click the patient information bar to view the 
patient’s profile. 

 

AUTOMATIC MODE CONTROLS 

In the automatic mode, the Details panel 
includes additional vital sign parameters and 
control options not available in the Manual 
mode. 

 

The “Hold” and “Auto” options are unique to 
the automatic mode. The “Auto Mode” 
adjusts vital sign controls with an (auto) 
suffix automatically.  

Checkmark “Hold” to prevent the Auto Mode 
from adjusting the value. Then change the 
vital sign to the new static value. The 
automatic mode will not change values set to 
hold. The “Auto Mode” will adjust all other 
controls set to “auto”. 

 

Some changes are gradual and even if 
submitted for immediate change. The delay 
results from using a closed loop model that 
adjusts to the target values over time, rather 
than displaying a unique value that is 
unrelated to other parameters. 
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LUNG CONDITION 

The lung condition parameter adjusts the 
shunt flow, dead space, airway resistance, 
and respiratory pattern automatically. 

 

TIDAL VOLUME 

In the automatic mode, a tidal volume of 450 
m/L to 500 m/L is considered the normal 
level for an adult of average build. 

The “auto mode” does not restore the 
respiratory rate if it is set to zero. 
Always remember to specify a new 
respiratory rate. 

 

CIRCULATION 

Each cardiac rhythm has a specific effect on 
the blood pressure waveforms. The pressure 
waveforms include ABP, CVP, PAWP, and 
Pulse. The blood pressure values are 
affected when any of the following 
parameters are changed: 

 Vascular profiles: vessel diameter and 
vessel stiffness 

 Heart Rate 

 LV Contractility 

 Total Blood Volume 

PATIENT STATUS  

Set the patient status to “Excited” (after 
exercise) to increases heart rate, 
temperature, respiratory rate, tidal volume, 
O2, CO2 diffusion capacity, metabolic rate, 
and CO2 formation rate. Set the status to 
“resting” for a normal state. 

 

BLEED AND WOUND SIZE 

The Bleed and Wound size options simulate 
blood loss virtually. To start the virtual 
bleeding click the “Bleed” button, and then 
adjust the bleeding rate using the “Wound 
Size” control.  

 

Once the bleeding function is activated, the 
Auto Mode will adjust the vital signs in 
response to the blood loss. If the provider 
does not intervene, the vital signs will 
deteriorate and myocardial ischemia will 
occur. For information on how to infuse 
blood to the model virtually, go to page 92. 
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CARDIAC 

The Cardiac irritability control adjusts the 
cardiac rhythms indirectly. Set the Cardiac 
Irritability to “improve” to move the current 
heart rhythm to normal sinus gradually. 
Alternatively, set the cardiac irritability to 
“deteriorate” to move the heart rhythm to 
ventricular fibrillation and eventually 
asystole. 

 

The progression of rhythms generally follows 
the pattern displayed in the figure below, 
where “X” represents normal sinus rhythm, 
multifocal atrial tachycardia, atrial flutter, 
atrial fibrillation, junctional rhythm, left or 
right bundle branch block, or atrio-ventricular 
block:  
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Virtual Monitor 
The interactive virtual monitor tab (VM) 
displays the patient’s vital signs information. 
The waveform and numerical parameters are 
interactive and the layout is fully 
customizable.  

 

WAVEFORM MENU 

Click the waveform name to access the 
waveform options.  

 

 Freeze - Pause the waveform reading. 
To unfreeze the selection, click the 
waveform menu and select “Go”. 

 Time - Set length of the ECG waveform. 
The options available are 5 seconds, 10 
seconds, 15 seconds, and 20 seconds. 

 Display - Open the waveform properties 
menu. Edit the waveform color, 
amplitude, intensity and scroll direction. 

CHANGING THE WAVEFORM 
TYPE 

To change the type of waveform displayed, 
click the waveform menu and select “close”. 

  

Click the empty waveform menu and select 
the new waveform type. While operating on 
the Automatic mode, the ECG option 
displays a sub menu for 12 individual leads.  

 

The new waveform type is now displayed 

 

NUMERIC MENU 

Click the numeric menu to access the 
numerical parameter options. To change the 
type of numerical parameter displayed, click 
the numeric menu and select “close”. 

 

Click the empty numerical menu and select 
the new parameter type. 

 

CHANGING VITAL SIGNS 

Numerical parameters can be adjusted 
directly from the virtual monitor tab. Double-
click the numerical parameter to open the 
floating control window. Adjust the parameter 
to the new value and submit the changes 
using the Apply NOW or trending options. 
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NONINVASIVE BLOOD 
PRESSURE 

By default, the NIBP parameter does not 
update automatically. Click the NIBP menu 
and select “Stat” to refresh the reading. 
Alternatively, set a refresh interval to 
automate the stat process periodically.  
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Palettes 
Use the Palette tab to sort, manage, and edit the palette items in the current profile. Each profile 
stores an independent library of palette items. 

To modify the vital sign parameters programmed into a palette, select a palette and click the Edit 
button. After the changes are made using the Details tab, click the “Save as Palette” Item button., 
See the Tips on Palette Item and Scenario Creation section of the appendix for more information 
on customizing palettes. 

Select a palette item from the list and click an a “Apply” button to update the vital signs to the 
values stored in the palette item. 
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Scenarios 

LINEAR SCENARIOS 

GIGA includes several preprogrammed scenarios to simulate a variety of complications. All 
preprogrammed scenarios are included in the “Quick Start Profile”. Click File>Profile to switch to 
switch to a different profile without exiting the software. 

To use a preprogrammed scenario go to the Scenario tab and click “Load Scenario”. 

 

The Load Scenario dialog box appears. Select a scenario and click on Load.  

LINEAR SCENARIOS OVERVIEW 

Scenarios automate changes to the patient’s condition to simulate an entire exercise without the 
need for manual input. A linear scenario is simply a playlist of vital signs palette items and wait 
palette items played back in succession. 

 

During the scenario, each vital signs palette updates the patient’s vital signs. The palette’s 
transition time trends the increase or decrease of numerical parameters (e.g. Heart rate, blood 
pressure) over seconds or minutes. In the figure below for example, the vital signs palette “Healthy 
Resting” is programmed with a transition time of 2 minutes. When the scenario reaches “Healthy 
Resting”, it will take 2 minutes for the vital signs to trend from the previous state to the values 
programmed within the palette. 

 

Wait palettes do not update or change vital signs. Instead, wait palettes give the participant time to 
perform an action; this may be treatment in response to a complication or performing a standard 
assessment.  

Vital sign 

Palette items 

Wait 

palette 

items 
Progress 

indicator 
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SCENARIO CONTROLS 

Scenarios are controlled using the playback buttons at the bottom of the tab. Intuitively, the click 
play, stop, pause, or next as necessary during the scenario. Click next to proceed to the next 
palette from a “wait indefinitely” palette. 

 

SCENARIO QUICK LAUNCH 

Use the scenario Quick Launch tab to start a scenario with a single click. The Quick Launch tab 
displays all the scenarios saved in the active profile. 

 

CREATING A NEW LINEAR SCENARIO 

Build new scenarios to expand the number of exercises available in a training program. The 
general process of creating a new linear scenario is the following: 

 Create a vital sign palette item for each state in the scenario 

 Add the vital signs palettes and wait times to the scenario 

 Play the scenario 

 Modify and edit palettes 

 Save the scenario 

CREATING PALETTE ITEMS 

The first step is to create several vital sign palette items using the Details tab. Each palette item 
represents a physiological state during the scenario. 

Program the first palette item to be used as the scenario’s starting point. Set values for all the 
physiological parameters, sound types, and volumes. This ensures that when the scenario begins 
no vital signs from a previous state will inadvertently carry into the scenario exercise.  

Reset 

Pause/

Play 

Next 

palette 

Previous 

palette 
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Using the list view controls, select the vital signs parameters for the starting physiological state in 
the scenario. Click the “Save as Palette Item” button to create the new palette. 

 

The “Save as Palette Item” dialog box is displayed. Type in the palette item name and a brief 
description; assign a color tag and click “Save”. 

 

Create the next palette item with only those vital sign parameters that are relevant to the second 
stage in the patient’s condition. Repeat this process to create palettes for the third and final stage in 
the scenario. Remember to program only the values that require change. After all the individual 
vital sign palettes are created, go to the “Scenario” tab and click “Add to Scenario”. 
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The Add Palette item menu displayed. Select the vital sign palette programmed to be first state in 
the scenario. Enter 0 min 0 sec for the transition time, so the initial vital signs are applied 
immediately. Click “Add” to add the palette to the scenario.  

 

The first palette is now added. Click “Add Palette to Scenario” button again to add more vital sign 
palettes and wait palette items. 
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A “Wait” item maintains vital signs values steady for the transition time allotted. Insert a “wait” item 
to give the provider time to perform an action or an assessment. For example, auscultating blood 
pressure or gathering general information about the patient. Alternatively, add “Wait Indefinitely” to 
hold the vital signs until the “next item” button is clicked from the playback controls. 

 

The wait palette item is now added.  

 

Add more palette items and then use the “Selected Item” menu to make any changes. 
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Click “Save Scenario” to store the scenario in the current profile for later use. 

 

Type in a name and a description for the new scenario and click Save. 

 

ADDITIONAL SCENARIO FEATURES 

Incorporate the following features into a scenario for added realism. 

 Auto responses –move onto the next palette item automatically when virtual electric 
therapy is detected 

 File sharing and lab reports – Send lab reports to the virtual monitor computer 

 Speech – add phrases or custom speech 
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FILE SHARING AND LAB REPORTS 

The scenario can also automate the distribution of shared files and labs. Click “Add to scenario”, 
and then use the “File” and “Lab” tabs to select from available documents. For more information 
making files available for file sharing, go to page 102. To create a new lab report, go to page 48. 

   

SPEECH 

Add realism to a scenario by integrating automated speech phrases. Click the Add to scenario 
button and select Speech. Then, select the type of speech and phrase using the drop down menus. 
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AUTO RESPONSES 

The scenario auto-response settings move the scenario to the next palette when electrical therapy 
is detected. Electrical therapy can be applied by the facilitator via Virtual Shock panel or by the care 
provider using real medical equipment if the simulator supports it. 

Auto-responses advance to the next palette if the virtual shock is applied while a “wait 
indefinitely” palette is playing and the heart rhythm is “shockable”. 

 

The three response options are defined below: 

 Off - The scenario does not respond to the electric therapy. 

 Prompt - The software detects the electrical therapy and prompts the user for approval 
before advancing to the next palette. 

 Auto – Advances to the next palette automatically only if the electrical therapy meets the 
threshold specified 
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Branching Scenarios 
Unlike linear scenarios, which move from one palette to the next, the trajectory of a branching 
scenario can change in response to the participant’s actions. Click the “Branching scenario” tab to 
access the branching scenario window. 

 

BRANCHING SCENARIO SCREEN 

Use the panel buttons to clear, load, and save new scenarios, or to switch from branching to linear 
scenarios. Click “Load Scenario” to access the preprogrammed branched scenarios in the current 
profile.  

 

CREATING A NEW BRANCHING SCENARIO 

The process of creating a new branching scenario is the following: 

 Add nodes  

 Add palettes or scenarios to each node 

 Add paths to nodes that require provider action 

 Create key events to alter the progress and trajectory of the nodes within the scenario 

ADDING NODES 

A branching scenario consists of several “Nodes”. Each node is preconfigured to run a normal 
scenario or a series of palettes simulating a specific condition or effect. Click the “Add node” button 
to create a new node for the first set of vital signs. 
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Click the node’s identifier number to edit the node properties. 

 

Enter a name for the node and description and then click “Save”. 

 

ADDING PALETTES OR SCENARIOS TO A NODE 

Click “Add Item” to add palette items or “Add Scenario” to add full scenarios to the node.  
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Add more nodes each with palette items to simulate every stage in the scenario. In this example, 
several nodes simulate the effects of medications that maybe administered to the patient by the 
provider. The first two nodes simulate the complication [1] Start Bradycardia, [2] Deteriorate. The 
following nodes: [3] Interventions, [4] Atropine, [5] Epinephrine, [6] Dopamine and [7] Pace are 
activated only when the provider administers the applicable medication or electrical therapy. Each 
node is programmed with palettes that simulate the effect described. 

 

ADDING PATHS 

A path refers to the trajectory from one node to another after the last palette in the node expires. 
The scenario will move on to the node indicated by the arrow. Click on the “Time Limit” icon to 
modify the “Go To” point for the default path.  
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In this example, the first node must move to “Node 2 - Deteriorate” after the time limit expires. Click 
“OK” to save the changes. 

 

Node 1 is now configured to proceed to Node 2 as indicated by the arrow. 

 

KEY EVENTS 

Key events activate alternate paths in a node. The alternate paths are used to change the 
trajectory of the scenario depending the participant’s actions. To add a key event to a node, first 
add the additional paths. 

 

Click the “Edit path” icon to program key events for the node. 
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A key event is the action expected by the participant. Type a name for the action and then click 
“Add”. 

 

After the action is added to the Key Events list, assign the node that this action will move the 
scenario to using the “Go to” menu. Click “OK” to save changes. 
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In the figure below, node 2 is configured with four alternate paths. Once the provider performs any 
one of the actions listed as key events, checkmark the key event to activate the alternate path. 

 

SAMPLE BRANCH SCENARIO DIAGRAM 

Node 
Node 
Name 

Description 

1 Start 
bradycardia 

Node vital signs palettes simulate bradycardia. Go to 
node 2. 

2 Deteriorate 

Vital signs palettes deteriorate the patient’s condition 
by -15%.  

Care provider has 4 options. Each option (key event) 
moves the scenario to the node specified. If no action 
is taken, the scenario will move to node 3 at the end of 
the time limit. 

Key event 

Atropine 

Node 4 

Epinephrine 

Node 5 

Dopamine 

Node 6 

Pace 

Node 7 

3 Intervention 

Wait indefinitely, vital signs are on hold. Provider is to 
intervene again. 

Key event 

Atropine 

Node 4 

Epinephrine 

Node 5 

Dopamine 

Node 6 

Pace 

Node 7 

4 Atropine 
Node vital signs palettes simulate the response to 
atropine. Time limit: Go to node 3 after 1 minute. 

5 Epinephrine 
Node vital signs palettes simulate the response to 
epinephrine. Time limit: Go to node 3 after 1 minute. 

6 Dopamine 
Node vital signs palettes simulate the response to 
dopamine. Time limit: Go to node 3 after 1 minute. 

7 Pace Vital signs simulate the effect of pacing. Scenario ends. 
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LINKED ACTIONS 

A “Linked Action - key event” triggers an alternate path when electrical therapy is detected. Click 
the Linked Action radio button and select the available actions. Then, set the electrical therapy 
thresholds or number of shocks require to trigger the action. Click “add” to create the key event. 

 

Set the “Go to node” from the drop down and click OK to save the changes. 

 

The key event is now programmed to move the scenario to node 8 if pacing is detected. 
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The “Linked Action” model medication tab is exclusive to the automatic mode. Program the 
medication linked action to trigger an alternate path when the system detects that the specific 
medication has been administered to the simulator. 
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Labs 
Use the Lab tab to create mock laboratory tests results to aid the participants during simulation. In 
addition, create new laboratory templates to supplement different types of scenarios. Once a 
laboratory report is created, send the file to the virtual monitor screen for the provider access during 
the exercise.  

 

PREPARING A LAB REPORT 

To create a new lab report with mock test results: 

 Click “Create a New Lab Report” on the right panel. 1.

 

The “Edit Lab Report” window is displayed. 
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 Select a “Lab Template” from the drop down menu. 2.

 

 Enter a report name, a report time, and a description. In addition, select a color tag for the lab 3.
report on the right panel. Color tags aid the sorting of lab reports on the report list window. 

 

 Enter the test results in the “Value” column. Include any comments associated with the test 4.
performed. 

 

 Click “Save” to create the lab report. 5.
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The newly created lab report is now listed in the “Lab Reports” section. Sort lab reports by name, 
template, description, or color tag. 

 

 Click “Preview” to review the final lab report. 6.

 

The preview window displays the test results how the provider will see them on the virtual monitor 
screen. If the computer is connected to a printer, click PRINT to create a hard copy. 
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SEND TO MONITOR 

Send the completed lab report to the virtual monitor screen to assist the care provider.  

To transfer the lab report to the virtual monitor screen: 

 First, select the report from the lab reports list. 1.

 

 Click “Send to Monitor” button to transfer the lab report to the virtual monitor. 2.

 

 An exclamation icon notifies the provider a file is ready for access on the Gaumard Monitors. 3.
Instruct the participant to click the patient menu drop down and select the lab report. 
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 The lab report opens using the system’s default application. 4.

 

 The letter Y represents a shared document. Click the “Stop Sharing button” on the right panel 5.
to remove the lab report items from the Gaumard Monitors menu.  

 

An editable copy of the lab report is stored inside the Gaumard_UI folder on the computer’s home 
screen. Go to page 102 for information on how to access other files from the Gaumard Monitor 
screen. 
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CREATING A LAB TEMPLATE 

Build new lab templates to supplement new scenarios.  

To create a new laboratory test template:  

 Navigate to the bottom of the tab and click “New Template”. 1.

 

The “Edit Lab Results Template” window is displayed. 

 

 Enter a name for the new template followed by a description. 2.

 

 Create categories to group a series of tests in a lab report. Click “Add” to create a new 3.
category. 

 

 Enter the name of the category and click “OK”. 4.
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 Click “add” on the “Single Entry” menu to create a new test under the current category.  5.

 

 Enter the name of the test, the unit, and decimal precision. 6.

 

 Enter a “Normal Range” the provider to reference. The normal range is visible on the lab 7.
report. The “Allowed Range” restricts the minimum and maximum value that can be entered a 
test result. Click “OK” to add the new test. 
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 Repeat the process to add more tests and categories. Click “Save” to create the new lab 8.
template. 

 

The new template is listed on the “Lab Template” section at the bottom of the Lab tab. Use the 
buttons on the left panel to edit or delete lab templates. 
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Speech 

PRERECORDED SOUNDS 

Select the Speech tab to command the 
simulator to speak aloud. The collection of 
speech and other sounds covers a wide 
range scenarios. In addition, use the 
streaming voice option to speak as the 
simulator’s voice and listen to the student 
responses. 

 

Click the phrase button to have the simulator 
speak the phrase aloud. Alternatively, 
program the phrases into a scenario to have 
the simulator speak automatically (page 56). 

 

STREAMING AUDIO 

Use the streaming voice to speak as the 
simulator’s voice and engage the provider in 
a realistic conversation. In addition, record 
and save custom phrases to be played back 
during scenarios automatically. 

Ensure that the headset and microphone is 
connected to the PC before starting the 
GIGA software. The headset minimizes echo 
and environmental noise to improve audio 
quality. 

 

 

Click the “talk” icon and speak in to the 
headset to talk as the simulator’s voice. 

 

To listen to the provider’s response, click 
“Listen”. 
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VOICE ACTIVATION 

Enable the “Voice Activation” feature to 
switch to the talk mode when voice input is 
detected automatically. Adjust the mic 
threshold to set the voice activation 
sensitivity. The higher the threshold, the less 
sensitive the microphone is; and vice versa. 
For instance, if the threshold is set to high, 
the voice input volume must be high to 
trigger the voice activation.  

 

VOICE CLARITY 

Voice clarity can be affected by 
several factors. To improve 
audio for the listen and talk 
options please review the 
following information. 

 Connect the headset to the 
computer before activating the 
Gaumard control software 

 Connect to the simulator using the 
strongest channel. Assign separate 
channels to each simulator if 
working with multiple simulators at 
a time. 

 Adjust the physical mic control 
attached to the headset cable. 

 Adjust the streaming voice “Output 
Gain” To raise the output gain in 
increments, tap and hold the 
control, then slide to the desired 
level. Higher gain levels increase 
the talk volume but degrade the 
audio quality. 

 Fine-tune the Windows® 
microphone settings.  

PRERECORDED SPEECH 

Create a library of custom recordings to play 
back as the simulator’s voice using the 
“Prerecorded Speech” feature. 

 

VOICE RECORDER 

To record a new custom phrase: 

 Click the “Rec” button and speak into 1.
the microphone. 

 

 Press “Stop” to finish recording.  2.

 Enter a name and click “OK.”  3.

 

 The new phrase is listed under the 4.
“Prerecorded Speech” menu. 
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Medication 
The Medication tab is exclusive to the automatic operating mode. Use the medication controls to 
simulate the physiological effects and reactions of medications administered to the patient model. 
To simulate the effects of a medication, the GIGA software processes the drug’s properties, 
dosage, and interactions, and then adjusts the patient vital signs accordingly. 

The Meds Profile includes a library of preprogrammed drugs. The built in drug editor allows 
facilitators to stay current with new medications or make changes to the properties of the existing 
drugs. All of the preprogrammed drugs included in the Med Profile library are found in the 2008 
Handbook of Emergency Cardiovascular Care published by the American Heart Association.  
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ADMINISTERING MEDICATIONS 

Follow this guide to administer a medication directly from the medication tab. Alternatively, go to 
page 126 for information on how to administer medications using the drug recognition arm and the 
tagged syringes. 

To administer a medication from the Medication tab: 

 Select the medication from the Drug drop down menu. 1.

 

A brief description is displayed at the top of the window. The half-life, peak time and drug 
concentration values are listed in addition to the standard and over dose dosage.  

 

 Enter the dose, units, route and rate (if applicable), and click “Administer”. 2.
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 The “Proceed Drug” window prompts to confirm the dosage effects before applying them. 3.
Adjust the peak effect percentage and/or the dosage effect, and then click “Yes” to apply the 
effects 

 

To turn off the Proceed Drug prompt, click Setup>Auto Responses and change the Drug Model 
Effect settings to “Auto”. 

The administered drug panel displays information on dosage rate, does administered, and total 
time of administration.  
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The Auto mode adjusts the patient’s vital signs to simulate the effects of the drug automatically. 

 

The blood pressure continues to decrease in response to the medication’s properties. 

 

 Increase the “Rate” factor to speed up the effect of a medication on the patient model. 4.

 

 Right click on the drug entry to access additional options. 5.

 

Select from the following options. 

 Unselect - Unselect a highlighted drug 

 Current Effects - View the effect on the patient’s vital signs 

 All effects - View all the available programmed drug effects for this medication 

 Drug effect toggle -Turn the drug effects on the patient model on or off 
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REMOVING A MEDICATION 

Drugs cannot be removed from the list during the administration process with the exception of IV 
infusions. To stop an IV infusion before it is finished, highlight the medication from the list, and click 
stop. 

 

After the dose administration is complete, select the drug and click “Remove from list”.  

 

To remove all the medications from the list and reset the effects on the patient model, click “File > 
New Session”. 

 

FLUID & GAS 

The automatic mode can process the administration of gas and/or fluids to the patient model.  

 

Select from saline, blood, or oxygen and the volume/concentration and rate. Click on “Start” to 
administer. 
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DRUG LIST MANAGER 

Click the “Manage Drug List” button to open the “Add New Medication…” manager.  

 

Use the “Add New Medication” manager to add new medications, edit medication properties, 
update existing items, and program medication interactions.  

 

Select a medication from the Medication List and click “edit” to view the medication’s properties. 
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CREATING NEW MEDICATIONS 

Each medication is programmed with two palette items. One palette item is programmed with the 
vital signs adjustments to simulate the effects of a standard dose (SD), and the other palette item is 
programmed with the effects of an over dose (OD). Additional information such as half-life, peak 
time, and route is also programmed into the medication properties. 

When the medication is administered to the patient, the software applies the palette item 
associated with the dose threshold. The Auto Mode adjusts the vital signs changed by the palette 
item gradually to simulate the medication’s effect on the patient. 

To create a new medication: 

 Create a palette item using details page for the effects of a standard dose (SD). Then, repeat 1.
the process to create a palette item for the effects of an over dose (OD). For general 
information on creating a palette items, refer to the Details tab section. 

  

 After dose effect palettes are created using the Details controls, go to the drug tab and click 2.
the “Manage Drug List” button. 
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The Add New Medication window is displayed. 

 

 Type the name of the new medication ( e.g. Generic Name (Brand Name)) and enter the 3.
medication’s description and the dosage information 

 

 Select the units and the administration route. 4.
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 Enter the drug’s Half Life and Peak time. 5.

 

 Enter half-maximal effective concentration. 6.

 

 Select the standard dose (SD) effect palette created earlier and then click the applicable 7.
dosage button to assign it to the threshold. Repeat this step to assign the over dose (OD) 
effect palette to the Over Dose threshold.  

 

 Select the threshold unit and set the dosage amount that will trigger the programmed palette 8.
effect. 
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 Click “Add” to save the new medication to the Medication List library. 9.

 

DRUG EFFECT TESTER 

After configuring the drug properties using the “Add New Medication...” menu, click the “Update 
Graph” button to generate the effect-plasma concentration results. Continue to the next section to 
program interactors for this drug. 
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DRUG INTERACTION EDITOR 

Use the “Interaction Editor” window to program drug interactions. When two or more medications 
preprogrammed to interact are administered, the physiologic model will adjust vital signs to 
simulate interaction effect. 

 

Click “Drug Interactions” on the “Add New Medication…” window to open the Drug Interaction 
editor. 
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PROGRAMMING INTERACTORS 

To program one or more medications to interact with the current drug: 

 Select the interactor from the drug list click “Add”:  1.

 

Information about the interactor drug is displayed in the Interactor Data window. 

 

 The drug is included into the interactors list. Repeat the process to add more drugs to the 2.
interactors list if necessary. 

 



70 | HAL | User Guide 

 Select the interactor and click “Edit” 3.

 

 Adjust the Max Alpha to modify the type of interactivity effect. Monitor the graph for a visual 4.

model of the plasma concentration. 

 Alpha = 1: Additive 

 Alpha < 1: Synergistic/Induction 

 Alpha > 1: Antagonistic/Inhibition 

 

TEST PANEL 

Use the test panel to simulate the interaction between the drugs based on dosage and time of 
administration. 
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To simulate the medications interactivity using the test panel:  

 Enter the patient’s weight and the dose for each drug. 5.

 

 Enter the time of administration for each drug and click “Update Graph”. 6.

 

The results indicate that the maximum interaction effect (82.39 %) occurs at 00:46:51. The alpha at 
that point is 1.01 and the drug effect for each drug is reduced by 0.90%. Fine-tune the Max Alpha 
control and retest if the drug interaction effect is not realistic. 

 

A time-effect graph is generated from the test results. Tap and hold to draw a zoom area. 
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 Right click anywhere on the graph access the zoon and print options. 7.

 

 Click “Confirm” to save the settings. 8.

 

 Review all the properties of the new medication in the “Add New Medication…” window, and 9.
click “Add” to save the new changes. 

 

In the example below, two drugs preprogrammed to interact have been administered. The 
interaction information is listed in the Interaction Status panel. 
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Evaluation Form 
The evaluation tool assists facilitators in reporting and assessing provider interaction using a 
questionnaire form. A completed evaluation form can then be stored as a digital document or 
printed for distribution. 

 

USING BUILT-IN EVALUATION FORM TEMPLATES 

Several preprogrammed evaluation templates included in the GIGA software. Each template 
includes a set of multiple-choice questions, fill in the blank, and true or false questions for a variety 
of scenarios.  

Select an evaluation template from the “Load template” drop down to begin. 

 

Enter the name of the facilitator administering the evaluation in On-Site Reviewer field. 
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Complete the form by answering each question. 

 

Click “Print” at the top right corner of the screen once the evaluation is completed. 

 

Select the Microsoft XPS Document writer to save the finished evaluation as digital document. Click 
“Print” to save the digital copy in the system. 
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Enter a name for the evaluation and click “Save”. 

 

PRINTING AN EVALUATION 

If the PC is connected to a printer, select and open the evaluation document saved in the previous 
step. 
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Navigate to the XPS Viewer file menu and select “Print”. 

 

Select the printer device from the list box and click print. 

 

It is recommended that documents be first saved as XPS files before being printed into hard 
copies. 
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CREATING NEW EVALUATION TEMPLATES 

Create new evaluation templates for new scenarios using the edit mode. To enter the edit mode, 
toggle the “Go To button” located on the top right of the evaluation form window. 

Enter a name for the new evaluation template in the “Evaluation Name” field. 

 

Click “Add” on the Category menu. 

 

Select the category type and enter the category title. Click OK to save. 

 

The new category is now created. 
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Highlight the new category and then click “Add” on the “Multiple Choice Entry” menu.  

 

Type the evaluation statement in the new multiple choice field.  

 

Repeat the previous steps to add more categories, questions, and multiple-choice options. 

 

After the evaluation template design is complete, click Save at the top of the window. 

 

The evaluation form is now available for use. 
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Provider Actions 
Use the Provider Actions tab to track actions performed by the provider manually. Each option on 
the Provider menu generates a time stamped entry in the text log below.  

 

SESSION INFORMATION 

Enter the session tile information and the name of the facilitator at the start of the session. The 
information is included in the final log report. 
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TEAM LOGGING 

The team logging feature is used to track the individual actions of up to six providers manually. The 
feature records the name of the provider with the action as an event entry in the log. 

To add a new provider to the Provider Actions” window: 

 Click Add” button to add a new provider. 1.

 

 Enter the provider’s name and select a color tag. Click OK to save the provider. 2.

 

 The provider is now added to the log tab. Repeat the steps to add up to six different providers. 3.
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TRACKING PROVIDER ACTIONS 

Provider actions can be tracked as a team or individually. Click the provider’s name to set the 
provider as active and track the actions individually. 

 

Click the appropriate option to track the action. For example, if the provider assesses the patient’s 
responsiveness by requesting them to open their eyes, click the “Assess responsiveness” button 
and select “Open your eyes”. 

 

The following log entry is generated with the name of the active provider who performed the action: 

 

Click the “Team” button to deactivate the active provider and return to general logging. Right click 
the provider button to delete or rename a provider. 
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CREATING NEW PROVIDER ACTION BUTTONS 

Create new clickable provider action buttons to expand the library of actions. To add a new action 
to an existing category: 

 Click the + button on the category 1.

 

 The category menu is displayed 2.

 

 Enter the name of the action and select the type of action 3.
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 Enter a description for the possible action and click + to add. Repeat the process to add 4.
several actions.  

 

 Click OK to save 5.

 

The new action is listed in the airway category. 
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Log 
The event log records a time stamped entry 
of events that occur during the simulation 
session. It addition, every individual entry 
records a snapshot of the vital signs 
parameters at the time the event occurred. 
The text log records the following events: 

 Vital sign changes applied manually 
or made by scenario 

 Events detected by onboard 
sensors (e.g. intubation sensor, 
defibrillation sites) 

 Preprogrammed speech phrases 

 Satisfactory or unsatisfactory 
evaluation  

 Facilitator notes 

 

Select an entry from the list and right click to 
view additional options. 

 

Select “patient vital signs” options to view a 
snapshot of the vital signs values when the 
event occurred. 

 

ADDING NOTES 

Enter notes into the “add to log” field to 
record notes manually. The information is 
categorized in the log as “NOTE”. 

 

CREATING A NEW SESSION LOG 

The log event “time stamps” reference the 
GIGA session clock. At the start of a new 
simulation exercise, click File>New Session 
to reset the session clock 00:00:00, reset 
any vital parameters settings, and clear all 
the event entries. 

 

SAVING THE LOG INFORMATION 

The log information is recorded in a rich text 
format. Export the log information to save a 
detailed history of the events that occurred 
during the session.  

To save the session log report as a text file: 

 Click FILE>Save report 1.

 Enter a name for the report 2.

 Select the desired name and path, and 3.
click “Save”. 
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Myocardial 
Infarction Editor 
Use the Myocardial infarction editor to create 
custom myocardial infarctions using an 
interactive model of the heart. The ECG 
generated displaying the effects of the MI 
can be loaded into the simulator so it can be 
detected using a real ECG monitor. 

To access the editor, click on the MI icon 
located on the side menu bar. 

HEART VIEWER 

To rotate the heart, click and hold the stylus 
button, then rotate the heart to the desired 
position. The zoom control and the reset 
rotation button are located on the right of the 
heart view window.  

 

MI CONTROLS 

Located on the left panel are the MI controls. 
These tools are used for creating myocardial 
ischemia, injury and necrosis. 

 

Load 

Use the load button to access 
built in MI models or access 
previously saved items. 

 

Save 

After the MI model is created, 
click Save to store the new preset 
to the system. 

 

Reset 

The reset MI model button resets 
all the settings to a healthy state. 

 

Undo/Redo button  

Move one step backward to undo. 

 

Help 

Use the help button to access a 
PDF version of the instruction 
manual. 

ADD OCCLUSION POINT 

Begin by clicking on the add occlusion point 
button on the menu. To auto generate MI 
from an occlusion, select any of the following 
options: Ischemia, injury and necrosis. The 
size of each MI type is adjusted by using the 
slider controls located on the right panel. 
After the occlusion point properties are set, 
click the location on the artery where the 
occlusion point will be generated.  

 



86 | HAL | User Guide 

To create an occlusion point without auto 
generating MI, deselect the MI types from 
the menu and select a point on the coronary 
arteries. Enable over paint to overwrite 
previous occlusions and MI. 

DELETE OCCLUSION POINT 

Click on the “delete occlusion point” button 
and select the green occlusion on the heart 
viewer using the modified cursor. Deleting an 
occlusion will also remove any MI that was 
previously generated. 

.  

MI PAINT BRUSH 

Click on the Paint Brush button to create MI 
using the modified brush tool. 

 

ERASE 

Begin by selecting the type of injury that will 
be erased, then use the modified cursor to 
delete the injury from the model. 

 

TIME PROGRESSION 

Click on the time progression button to 
convert the MI or select the secondary 
control to adjust the age of the infarction. To 
apply the change, click Process. 

 

ECG CONTROLS 

Once the MI is created, the 12 lead ECG can 
be saved for use within a palette or a 
scenario. Use the ECG controls to save, 
print, preview, zoom and magnify. 
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 SAVE ECG 

Click the Save ECG button to display the 
following options. 

SAVE AS RHYTHM 

Choose Save to Library” then enter a name 
for the new rhythm in the “Save as Rhythm” 
window and click OK. 

 

The new custom heart rhythm will be 
available as an option in the ECG 
physiological parameter control. Once the 
heart rhythm is selected, it can be 
incorporated into a palette or applied 
immediately. 

 

SAVE AS IMAGE 

Choose Save Image to store a snapshot of 
the ECG. When prompted, select a location 
to save the image. 

PREVIEW ECG 

Use the preview button to display the 12 lead 
ECG onscreen with an additional 2 full length 
leads or a preview with RV + PW. 

 

12 LEAD 

Click 12 lead and select two full length leads 

to display in addition to the 12-leads. 

 

Click ok to display the preview window. 
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ECG Designer 
Use the ECG designer to create a custom 12 
lead rhythm. Click the ECG designer button 
to open the ECG designer window.  

  

After a rhythm is created and saved, 
navigate to the designer tab to load the 
custom rhythm. 

 

EDITING AND CREATING 12 LEAD 
RHYTHMS USING THE ECG 
DESIGNER 

ECG designer starts with a set of flat lines in 
all waveforms. From this point, new rhythms 
can be created, or existing rhythms from the 
GIGA library can be edited and saved as 
new waveforms. Rhythms drawn in the ECG 
Designer are assumed to be at 60 beats per 
minute, with any morphology changes as a 
result of lower or higher rates being 
automatically handled by the software. 

 

To edit an existing rhythm, select it from the 
Cardiac Rhythms list on the top right hand 
side of the ECG Designer window. New 
rhythms can be created by simply adding 
and manipulating points on the default flat 
lines of the ECG Designer window. 

Once a rhythm is loaded, it can be edited by 
clicking and dragging the dots on waveforms 
II, III and V1-V6 In the precordial leads the 
dots lie on a green line which shows the 
waveform generated at the site, while the 
waveform detected at the patient monitor is 
shown as a thin black line. 
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Dots can be added by right clicking on the 
waveform line, or on the green line for leads 
V1 through V6. The Preview button in ECG 
designer hides the editing dots to provide an 
uncluttered image of the working rhythm. 

 

Note that because waveforms I, aVR, aVl 
and aVf are dependent on lead II, they 
cannot be edited directly. 

HEART SOUNDS TIMING 

In order to properly time the heart sounds in 
custom rhythms, it is necessary that the user 
identify points P, R and T within the Lead II 
waveform. These points are colored Blue, 
Red and Purple, respectively. 

 

In order to identify points P, R and T, right 
click over the desired point and select the 
appropriate letter. 

 

VARIABLE SEGMENT 

A variable segment identifies the line 
between two points that can be extended 
and reduced as the heart rate decreases and 
increases. If present, this segment needs to 
be identified on all lead waveforms. 

CONTROL PANEL 

To save a customized rhythm, enter a name 
in the Save textbox on the right side of the 
window and click on the Save icon 

 

Rhythms included as part of GIGA Module’s 
ECG library cannot be deleted; however, 
they can be edited. Modified rhythms can be 
applied directly from the “Designer” tab of 
the Rhythm Selection window on the Details 
tab. Changes made to default rhythms can 
also be rolled back by selecting the desired 
rhythm and clicking on the Restore button of 
the ECG Designer window. 
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EDITING CONTROLS 

The Link Points controls can be used to drag 
sets of points left or right without modifying 
an existing drawing. This function can be 
useful to align waveform features (such as 
QRS complexes) across several lead 
waveforms. 

 

 
Restore/Delete 
 

Zoom In/Out of 
Lead 

Undo/Redo 
Changes 

Link Points Left / 
Right  

Atrial and 
Ventricular 
Contraction 
Efficiency 

Beep on R 
Checkbox 

The Atrial and Ventricular Contraction 
Efficiency values are used by GIGA’s 
Automatic Mode to determine parameters 
such as blood pressure and oxygenation. 

The Beep on R value informs the Gaumard 
Virtual Monitors (if available) that an ECG 
beep should occur at the point designated as 
the R on the Lead II waveform. 
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CPR Evaluator 
GIGA features a CPR performance evaluator 
and trainer. Click the CPR icon on the 
vertical menu bar to open the CPR window. 

 

The CPR evaluator feature provides real 
time feedback on the provider’s compression 
and ventilation performance. 

 

The provider performance indicator boxes 
are located on the right. The V (ventilation) 
and C (compression) box fill color changes 
between the following states: 

 

 Grey – No intervention was detected. 

 Yellow – Compression was too shallow. 

Ventilation was too weak. 

 Green – Compression/ventilation was 

performed correctly. 

 Red – Compression was too deep. 

Ventilation was too strong. 

Compression and ventilation data is 
displayed at the bottom of the window as 
CPR is performed by the provider. 

 

Compression Data 

 Rate – Rate of compressions in real 

time. 

 Ct – (Compression time) – Average 

length of each compression in seconds. 

 LC – (Last Compression) – Time 

elapsed since the last compression 
performed. 

Ventilation Data 

 Rate – Ventilation rate in real time. 

 PIP – (approx.) Peak Inspiratory 

Pressure 

 Ti – Time Inspiration 

 I:E – Inspiratory: Expiratory Ratio 

 PEEP – (approx.) Positive end-

expiratory pressure 

 LV – (Last Ventilation) – Time elapsed 

since the last ventilation performed. 
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TRAINER 

The CPR trainer reference boxes generate a 
visual prompt of the compression to 
ventilation ratio programmed in the “CPR 
Options” menu. Click the “Trainer” button to 
start. The V (ventilations) and C 
(compressions) box borders blink to indicate 
the correct reference CPR rate. 

  

CPR OPTIONS 

By default, the CPR trainer is configured to 
blink the reference borders at a 30:2 
compression to ventilation ratio. To change 
the ratio, navigate to the menu bar and click 
the CPR dropdown and CPR Options. 

 

PERFORMANCE EXAMPLES 

Compressions are too shallow. Waveforms 
mostly do not reach the green zone. 
Compression indicator is yellow. 

 

Compressions are too deep. Waveforms 
mostly exceed the green zone. Compression 
indicator is red. 

 

Compressions are performed correctly. 
Waveform peaks are mostly inside the green 
zone.  

 

Ventilations are too shallow. Waveform 
peaks do not reach the green zone.  

 

Ventilations are too strong. Waveform peaks 
exceed the green zone. 

 

Ventilation was performed correctly. 
Waveform peak is inside the green zone. 
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File Menu 

File 

 

PROFILE 

Click the Profile menu option to open the 
Profiles menu. To switch to a different profile, 
select the operating mode and the new profile 
and click “Load”. 

NEW SESSION 

Clicking New Session in the file menu will: 

 Clear any loaded/playing scenario 

 Clear any loaded/playing palette 

 Reset vital signs to normal values 

 Clear out log page 

 Restart the session clock.  

The session clock is located at the bottom of 
the dialog box. 

 

The shortcut key for staring a new session is: 
Ctrl + N 

RESET SESSION CLOCK 

Clicking on Reset Session Clock resets the 
clock back to zero. It does not have any effect 
on the transition time remaining on a scenario; 
it does not reset the vital signs, or clear out 
loaded scenarios. The facilitator can also reset 
the session clock by clicking on the Session 
button next to the session time. 

 

SAVE REPORT 

This option allows you to save all the 
information recorded in the log page as a text 
file. Clicking on it brings up the “Save As” 
dialog box: 

 

Select the desired name and path, and click 
“Save”. 

The shortcut key for saving a report is Ctrl + S. 
For a sample report, look at the figure below: 
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PRINT REPORT 

This option allows you to print a text file 
containing all the information in the log for the 
latest session. Clicking on “Print Report” brings 
up the Print dialog box. The shortcut key for 
this option is Ctrl + P. 

IMPORT 

Use the “Import” menu to import palettes, 
scenarios, and modeling patients created on 
another PC or stored in a backup location. 

To import an item into GIGA: 

 Click File>Import on the menu to access 1.
the “Open” menu.  

 Set the type of file to import. 2.

 

 Browse to the location where the item is 3.
saved and click “Open” to import. 

 

The scenario file is copied to the GIGA 
scenario library automatically. 

EXPORT 

Use the Export feature to backup palettes, 
scenarios (branched or linear), and model 
patients files. 

To export an item and save it to a location on 
the computer: 

 Click File > Export to open the “Export” 1.
menu  

 Select the file type from the “Export File 2.
Type” drop down menu: 

 

 Select the item to export from the list and 3.
click “Export” 

 

The “Save As” window is displayed. 

 

 Browse to the location where the file will 4.
be saved and click “Save”.  

 

EXIT 

Click File > Exit to close the GIGA software 
and turn the simulator off. Alternatively, click 
the power bottom and click the X icon near the 
top corner of the screen. 
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Setup 

 

CALIBRATION 

Use the Calibration menu to calibrate the 
simulator’s features and to reset the sensors 
back to default settings. 

 

Chest rise will stop when the 
“Calibration” menu is active. 

 Chest compressions 

 Artificial Ventilations 

 Blood Pressure Cuff 

 Oxygen Saturation 

 IV Medication Infusion (Drug recognition) 

CHEST COMPRESSIONS  

The chest compression calibration wizard 
records the average depth (as pressure) of 5 
chest compressions. GIGA evaluates provider 
performance using the information recorded 
during the calibration as the correct 
benchmark. 

To calibrate the compression performance 
benchmark: 

 Click Setup > Calibration > Chest 1.
Compressions, and click “Next” 

The wizard prompts to perform compression 
“#1” 

 Perform one chest compression correctly. 2.
A green filled oval indicates that the chest 
compression was recorded successfully. 

 Perform chest compression # 2 as 3.
prompted by the wizard. A green filled 
oval indicates that the chest compression 
was recorded successfully 

 Continue the calibration process to record 4.
a total of 5 compressions as prompted by 
the wizard 

At the end of the calibrating session, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the settings.  

Please test the compressions 
calibration using the CPR trainer. Go to 
page 91 learn more about the CPR 
trainer and the feedback graphic. 

VENTILATIONS 

The ventilation calibration wizard records the 
average pressure of 5 ventilations. GIGA 
evaluates provider performance using the 
information recorded during the calibration as 
the correct benchmark. 

To calibrate the ventilation performance 
benchmark: 

 Click Setup > Calibration > Ventilations, 1.
and click “Next” 

The wizard prompts to perform ventilation “#1” 

 Perform one ventilation correctly. A green 2.
filled oval indicates that the chest 
ventilation was recorded successfully 

 Perform ventilation # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the ventilation was recorded 
successfully 

 Continue the calibration process to record 4.
a total of 5 ventilations as prompted by the 
wizard 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the settings.  
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Please test the compressions 
calibration using the CPR trainer. Go to 
page 91 learn more about the CPR 
trainer and the feedback graphic. 

BLOOD PRESSURE CUFF 

Calibrate the Blood pressure cuff feature if the 
Korotkoff sounds do not match the systolic and 
diastolic values set using the GIGA controls. 

Before starting the calibration process, place 
the blood pressure cuff on the simulator as it 
would be placed on a real human patient. 

To calibrate the blood pressure feature: 

 Click Setup>Calibration>Blood pressure 1.
and click “Next” 

 Verify which arm will be calibrate and click 2.
“Next” 

 Set the pressure on the BP cuff to 0 (i.e. 3.
cuff valve open) as prompted by the 
calibration wizard. 

 Click the “OK” button to record the current 4.
cuff pressure for the interval. A green filled 
oval indicates the pressure interval was 
recorded successfully.  

 Set the pressure on the BP cuff to 20 5.
mmHg as prompted by the wizard. Click 
“OK” to record 

 Continue increasing the BP cuff pressure 6.
as indicated by the prompt and recording 
the pressure intervals. 

 At the end of the calibration wizard, click 7.
“Finish” to close the calibration wizard. 

OXYGEN SATURATION  

Complete the “Oxygen Saturation” calibration 
wizard to calibrate the simulator to work with a 
specific oxygen saturation monitor and sensor. 
GIGA stores calibration settings for one device 
at a time. If the oxygen saturation monitor or 
the sensor is changed, the simulator must be 
recalibrated to work with the new device. 

 

Disclaimer: Oxygen saturation monitors 
that detect carbon monoxide and/or 
methemoglobin are not supported. 

To calibrate the oxygen saturation finger: 

 Turn OFF the oxygen saturation monitor 1.
and place the oximeter sensor on the left 
index finger. Verify that the left index 
finger is centered inside the finger sensor. 

 Go to Setup>Calibration and select 2.
“Oxygen Saturation”. Click “Next” to 
continue. 

 Turn ON the oximeter and click “OK” on 3.
the dialog box. 

 Adjust the reading on the oximeter 4.
monitor screen to match the value 
displayed on the GaumardUI calibration 
screen using the arrows on the left column 
of the calibration dialog box. The first 
calibration point is 98%. 

Use the triple arrows to increase or 
decrease the reading on the oximeter in 
large intervals. Use the double arrows for 
moderate changes, and the single arrows 
for small changes of one or two percent 
readings. Wait 10-15 seconds after 
making an adjustment to allow the 
oximeter reading to stabilize. This ensures 
proper calibration. 
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 After the value on the oximeter screen is 5.
stable, and it matches the value on the 
GaumardUI calibration window, click “OK”, 
and then “Next” to continue. 

 Repeat the process to calibrate the 6.
following intervals. 

 Click “Finish” at the end of the calibration. 7.

TESTING THE OXYGEN 
CALIBRATION 

To test the oxygen saturation calibration:  

 Go to the details page and vary the 1.
oxygen saturation value on the software.  

 Observe that the oximeter reading 2.
coincides with the value shown on the 
status panel (±3 differences are 
acceptable on readings above 80%).  

 Test calibration at two points; values 3.
between 80% and 95% are 
recommended. 

 Now take the oximeter sensor off the 4.
finger, wait for five seconds, and place the 
sensor on the finger again in the same 
position used during the calibration 
process.  

 Check that the oximeter reading coincides 5.
with the value specified on the Details 
page (±3 % value differences are 
accepted). 

If both readings do not coincide, make sure to 
slide the finger all the way into the oximeter 
sensor. For additional information on 
troubleshooting the oxygen saturation feature, 
please go to page 96. 

IV MEDICATION INFUSION 
(OPTION) 

Calibrate the IV medication infusion when the 
infusion rate shown on the drug tab is 
inaccurate. The IV medication infusion 
calibrated and tested at the factory. 

WARNING: The simulator must be on 
when introducing fluids into the drug 
recognition arm. This includes calibration, 
purging, draining, IV infusion, and injecting 
fluids into the veins or the filling ports. 
Introducing fluids into the drug recognition 
arm while the simulator is off will damage 
the arm and the simulator. Damage caused 
by improper use is not covered under 
warranty. 

The drug recognition arm is equipped with 
a black drain port and a white filling port. 
Do not reverse the ports while introducing 
fluids into the system; doing so will 
damage the system. Do not attempt to fill 
the IV system without the black drain 
connector in place. Always leave the black 
drain port connected during high volume 
infusions. 

To calibrate the IV Medication Infusion feature: 

 Locate the “drug recognition fill kit” 1.
included with the package 

 Connect, turn, and lock the drain tube to 2.
the black drain port. Place the end of the 
drain tube inside a container lower than 
the arm in order to siphon the fluids in the 
next steps.  

Keep the drain tube connected 
throughout the entire calibration 
process. 

 Connect, turn, and lock the kit syringe 3.
filled with clean water to the white fill port 

 Verify that the simulator is on 4.

 Inject water into the arm until it exits 5.
through the drainage hose and into the 
container 

 From the calibration menu, select “IV 6.
Medication Infusion” and click “Next” 

 As prompted by the calibration window, 7.
slowly inject 20 ml of fluids in the forearm 
using the fill syringe  

 The menu screen displays the volume 8.
injected. Once the onscreen value 
reaches 20 ml, click “OK”. 

 Continue the process as directed by the 9.
onscreen instructions until each interval is 
calibrated 

 Click “Finish” to save the new calibration. 10.



98 | HAL | User Guide 

FACTORY SETTINGS 

Use the Factory Settings menu to restore 
sensors settings back to the factory default 
values. Resetting the sensors deletes all 
current calibration settings. 

 

Remove all adjuncts, or peripherals that 
may alter the neutral state of a sensor 
prior to resetting it. 

Click the sensor button to reset it to the factory 
setting. Please refer to the troubleshooting 
guide on page 168 if a sensor does not 
respond. 

OPTIONS 

 

GENERAL 

Configure general GIGA settings and options. 

AUTO-SAVE 

Save the log report automatically every 
number of minutes. 

SESSION TIMER 

Reset the session timer at the start of a linear, 
branching, or labor scenario. 

ELECTRICAL THERAPY PANEL 

Display the defibrillation panel shortcut on the 
vertical menu bar. Use the electrical therapy 
panel to defibrillate and pace the simulator 
virtually. 

STAND BY WARNING 

Display a notification when attempting to apply 
new settings while the simulator is in stand-by 

UNITS 

Change the unit type displayed on the control 
software and the virtual monitor software. 

ENVIRONMENT 

Generic: Select “Generic” to scan and connect 
to the nearest simulator. All upgrade features 
are disabled while using the Generic 
connection mode. 

Fixed: Select “Fixed” and enter the simulator’s 
serial number to connect to the simulator 
without scanning. Upgrade features are serial 
number dependent. Enter and save the serial 
number in the “Fixed” field before entering an 
add-on activation code. 

Channel: Set the wireless channel used to 
connect to the simulator manually. Assign an 
individual channel to each simulator if multiple 
simulators are in close proximity of each other. 

Check noise in channel: Checkmark “check 
noise in channel” to force the software to 
switch to a clearer channel if wireless 
interference is detected. 

HAL ADD-ONS 

Enter the applicable upgrade code to activate 
the upgrade option. Activation codes are 
unique to the simulator’s serial number. 
Ensure the simulator’s serial number is saved 
in the Environment tab “Fixed” option before 
entering the activation code. 

HAL VIRTUAL MONITOR 

Use HAL Virtual Vital Signs Monitor - Enter the 
upgrade code to enable the “Monitors” menu 
option in the file menu. Open the 
Monitors>Configuration menu to configure the 
vital signs broadcast connection settings. 

HAL KITS 

Use Leg trauma Kit - Checkmark to display the 
trauma leg bleed controls. 

Use arm trauma kit - Checkmark to display the 
trauma leg bleed controls. 

Use Automatic NIBP Kit - Checkmark to 
enable the non-invasive blood pressure 
feature. The NIBP feature disables the manual 
blood pressure feature. 
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AUTOMATIC MODE 

Enter the Automatic Mode activation code to 
enable the automatic operating mode option in 
the profile menu. 

HAL PULSES 

Set the pulse strengths for the normal blood 
pressure of (120/80) 

Set the systolic minimum threshold for each 
site. 

LOG 

Log event text entries are color-coded. Use the 
log tab to customize the color of each log entry 
type. 

PACING SHOCK 

GIGA can detect small variations in the heart 
rate and current during pacing. Each variation 
could trigger a programmed auto response or 
create a new entry in the log event. Adjust the 
threshold for each parameter so only the 
changes greater than the ones specified will 
be detected by the GIGA software. 

TOLERANCES 

Use the Tolerances controls to adjust error 
margin allowed by the CPR intensity and rate. 

The simulator’s pupils react to light. Use the 
“Pupil Sensitivity” controls to recalibrate the 
pupil reaction if dilation is erratic. 

Set ambient light - Click “Set ambient light” to 
recalibrate the pupil diameter to the current 
ambient light. 

Set Dilation Light - While covering both eyes 
from most incoming light, click "Set Dilation 
Light" to set the low light pupil diameter. 

Increase/Decrease Sensitivity - Click increase 
or decrease to adjust the pupil’s sensitivity to 
light 

Reset to Default: Reset the pupils’ ambient 
and dilation settings to the factory settings. 

CPR OPTIONS 

Customize the compression to ventilation ratio 
signaled by CPR Trainer prompt. 

Set the number of compressions per minute 

Set the compression/ventilation ratio 

Set number of ventilations per minute (if the 
‘Only Ventilations’ button is selected). 

OTHER 

Checkmark "Once a 'Palette' is applied load to 
“Details Tab'" to show the value of each 
palette’s vital signs parameter on the Details 
tab control fields. 

Checkmark the “Link respiration sensor to 
ECG leads sensors” to generate artifacts with 
each compression. 

Checkmark the “Use A/V” to display the audio 
and video configuration menu on the menu 
bar. 

REMOTE ACCESS VIA NETWORK 

The “Remote Access via Network” feature 
allows GIGA to communicate with the 
simulator remotely using the virtual monitor PC 
as the RF transmitter. The alternate 
configuration may provide better connectivity 
in environments with numerous walls or 
obstructions between the simulator and the 
control PC. 

 

The USB RF module drivers must be 
installed on the virtual monitor PC 
before the “Remote Access via 
Network” feature can be configured.  

Go to www.Gaumard.com to download 
the latest USB RF module drivers using 
PC with internet access. Do not connect 
the Virtual Monitor PC to the internet. 
Transfer the USB RF module setup file 
to the virtual monitor PC using a USB 
drive and complete the installation. 

To configure the “Remote Access via Network” 
connection: 

1. Connect the simulator’s USB RF module 
an available USB port on the virtual 
monitor PC 

2. Verify that both computers are connected 
to the ad-hoc network (e.g. GaumardNet,) 

3. Initialize GIGA on the tablet PC open the 
Remote Access via Network menu from 
the Setup menu 
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4. Select the Remote access via network 
radio button 

5. Verify that Wireless Network Connection 
is selected from the adapter list 

6. Click “Find available” to auto configure the 
port used for this connection 

7. Write down the controller IP and port 
number, then click “Connect” 

8. Navigate to the V menu on the virtual 
monitor computer and select “Remote 
access Via Network” 

Please wait 30 seconds for the feature to 
initialize 

9. Enter the “controller IP” and “port number” 
as shown on step 7 and click “connect” 

AUTO RESPONSES 

The Non-Scenario Automatic Response 
feature allows the facilitator to set 
preprogrammed responses to electrical 
therapy events. When the electrical therapy is 
detected, auto-responses can automatically 
load a specific palette item or prompt the 
facilitator before making preprogrammed 
changes to the simulator’s vital signs.  

Non-scenario response settings detect 
electrical therapy administered when a 
scenario is not in progress. For information on 
how to configure auto-responses for use 
during a scenario, go to page 39. To activate 
the virtual shock panel for administering 
electrical therapy virtually, go to page 98. 

 

The behavior of each auto response option is 
explained below: 

 Off - The software does not respond to the 
electric therapy 

 Prompt - The software detects the 
electrical therapy and prompts the 
facilitator before applying the changes 
configured in the “Settings” section. 

 Auto - The software automatically detects 
the electrical therapy and compares it to a 
threshold selected by the provider. If the 
threshold is met, the vitals will 
automatically change to the parameters 
specified on the “Settings” section. 

Each type of electrical therapy has a unique 
set of default parameters. For example, the 
default response to a defibrillation Shock 
applies the following vital sign parameter 
changes: NSR, 75 bpm, BP 120/80. Click the 
palette button to program a specific palette 
item as an auto-response. 

 

Select the desired palette from the “Load 
Palette Item…” window and click “Load”. 
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The defibrillation shock auto-response is now 
configured apply the “Healthy Resting” palette 
if a virtual defibrillation shock of 200 Joules or 
greater is detected. The programmed 
response palette is listed in the “settings:” 
panel. 

 

AUTOMATIC MODE NON-
SCENARIO AUTOMATIC 
RESPONSES 

The “Automatic Mode non-scenario Automatic 
Responses” are unique to the automatic mode. 

Link All Auto Response to Cardiac Irritability - 
Auto-responses will work only if the cardiac 
irritability option on the details page matches 
the selection on this window.  

 

An event prompt is displayed if electrical 
therapy is detected and the cardiac irritability 
set does not match the selection on the 
responses window.  

Drug Model Effect – Configure the auto-
response behavior for drug administration. 

 Auto – Apply the drug effects based on 
medication’s programmed properties and 
dosage  

 Prompt – Display a confirm prompt before 
applying the drug’s effects 

SET MED ID 

The “Set Med Id” menu is accessible when the 
software detects the Drug Recognition Arm on 
the simulator. Use the Set Med ID menu to 
program the tagged syringes with a medication 
type and a concentration. To program a 
syringe with a medication to work with the drug 
recognition arm, go to the “Working with the 
simulator section of the user guide.” 

SCAN RF CHANNELS 

Use the Scan RF Channel tool to search for 
the strongest RF communication channel 
available.  

Click the “Scan RF Channels” 
option in the setup menu to start the scan. 
Please wait while the system completes the 
process. 

 

The tallest bar represents the strongest 
channel. Double click the bar to connect to the 
simulator using the channel selected. 

 



102 | HAL | User Guide 

Monitors 

Use the Monitors drop down menu to 
enable/disable sensors on the virtual monitor 
screen, share files, program custom scalars, 
and verify the connection between the GIGA 
and Gaumard Virtual Monitor software. 

 

If the “Monitors” drop down is not 
showing, go to Setup>Options> Add-
ons, and checkmark “Use Virtual Vital 
Signs Monitor.” 

SENSORS 

Use the sensors option to enable or disable 
any of the waveforms displayed in the vital 
signs monitor. Select the waveform and click 
“ON” to display the readings on the virtual 
monitor screen. To disable a parameter 
reading, click “OFF”. The vital signs monitor 
sensors defaults to “All On.”  

 

Some sensors, such as NIBP and 
Thermometer feature a STAT control that will 
allow the facilitator to activate readings on the 
virtual monitors from the controller software. 

SENSOR CONTROL WINDOW 

The sensor control window is a floating panel 
with on/off toggle controls. Click Monitors> 
Sensors> Window to open the floating sensor 
control panel.  

 

Single click the circular icon to enable or 
disable the sensors displayed on the virtual 
monitor screen. Click the circle dark to disable 
the sensor and light blue to re-enable it. In the 
example above, all the sensors are on except 
the thermometer. 

FILE SHARING 

The file sharing menu allows the facilitator to 
send images, audio, and text files to the virtual 
monitor screen. Use the file sharing feature to 
fulfill file requests by the provider during 
simulation. 
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The files used for sharing are stored in the 
control PC. Before the simulation begins, add 
mock image (.jpg, .bmp) or text files (.txt) into 
the Gaumard_UI folder located on the home 
screen of the control computer. 

 

Open the “File Sharing” menu. 

 

The list of files stored on the Gaumard_UI 
folder available for sharing is displayed on the 
left panel. To share a file, select the file from 
the left panel and click “Add”. 

 

Enter a context name on the pop-up menu and 
click “OK” to share. 

 

Files currently shared are listed on the “Shared 
Files” list.  

 

A yellow notification icon is displayed on the 
patient menu at the top left of the virtual 
monitor screen. The icon notifies the provider 
that a file is available for viewing. Click the 
patient menu and select the file open it. 

 

The x-ray file is now open on the virtual 
monitor computer. 
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To unshared the file, select the file from the file 
sharing menu and click remove. 

 

To troubleshoot file sharing access errors, 
please reference the Gaumard Monitors user 
guide. 

CUSTOM NUMBERS 

Use the custom numbers feature to add 
custom numerical parameters to the Gaumard 
Monitors screen. For example, glucose levels 
or platelets count.  

On the GIGA menu bar click Monitors>Custom 
Numbers to open the “Custom Numerical 
Parameters on Monitor” menu. Click the “Add” 
button to create a new parameter. 

 

Type the name and units of the new parameter 
and then click “OK”. 

 

The scalar parameter is now created. Enter a 
value for the parameter and click “Update”.  

 

On the virtual monitor screen, click on a 
scalar’s menu and select “Close” to make the 
entry available for the custom parameter.  

 

The scalar entry is now a blank field. 

 

Click on the empty scalar menu and select 
“Other” from the list of available scalar 
parameters. Select the name of the custom 
parameter. 
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The figure below shows two new values: 
Glucose level and hematocrit levels. Return to 
the custom parameter menu on the GIGA 
software to update the values when 
necessary. 

 

CONFIGURATION 

On the GIGA menu bar, click 
Monitors>Configuration to open the “Virtual 
Monitor Setup” window. Use the setup window 
to verify the connection between the GIGA 
software and the Gaumard Monitors vital signs 
software, re-configure the communication 
ports, and view the controller IP address. To 
troubleshoot connectivity issues between the 
two computers, please turn to page 174. 

CONFIGURE THE VITAL SIGNS 
BROADCAST 

After the wireless ad-hoc link is established 
between both computers, complete next steps 
to configure the transmission of the vital signs 
information.  

1. Verify that both computers are connected 
to the GaumardNet network using 
Windows

®
 wireless connection menu. If 

the computers are not connected, select 
the “GaumardNet” network and click 
“Connect” manually. 

 

2. Start the GIGA control software. 

3. On the GIGA menu bar, click Monitors> 
Configuration. 

The “HAL Virtual Monitor Setup” window is 
displayed. 

4. Set the adapter to “Wireless network 
connection” and click “Connect” to begin 
transmitting the vital signs information. 
Write down the “controller IP” and “Port 
number”.  

5. Start the Gaumard Monitors software on 
the virtual monitor PC. 

6. Click the “V” menu near the top left 
corner, and then select “Comm Setup”. 

The “TCP Comm Setup” window is displayed. 

7. Enter the “Controller IP” and “Port 
number” displayed on the GIGA “Virtual 
Monitor Setup” window.  

Click “Connect” to accept the incoming 
connection. 
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Modeling 

The “Modeling” drop down menu in the top left 
corner of the GIGA contains four options: 
Modeling Patient, Reset Model, Import 
Between Patients, and Auto Log Setting. 

 

MODELING PATIENTS 

This option allows you to create a new patient 
or load an already existing one. 

 

To create a new patient, go to Modeling, 
Modeling Patient, new patient. The following 
dialog box is displayed: 

 

Enter the name of the patient, age, gender, 
height, weight, and/or additional notes. Then, 
click “Save”. 

To load an already existing patient, go to 
Modeling, Modeling Patient, Load Patient. 

 

Select the desired patient, and click on Load. 
Notice that the factory pre-set patient HAL 
cannot be deleted, as opposed to any of the 
patients that you create yourself, which can be 
deleted. 

Patient information is displayed on the right 
side and near the top of the Details tab. 

RESET MODEL 

Clicking on Reset Model under the Modeling 
drop down menu, will restore all vitals and 
physiologic controls to normal state. For 
instance, if the ECG rhythm is currently on 
Ventricular Fibrillation, clicking on reset model 
changes the ECG rhythm back to sinus.  

IMPORT BETWEEN PATIENTS 

Use the “Import between patients” menu to 
import palettes, scenarios, and branching 
scenarios from other patient profiles into the 
current active one.  

 

To import an item another patient in to the 
active patient:  

 Click Auto Mode> Import Patient to open 1.
the ”Import” menu 



HAL | User Guide | 107 

 Select the item category to import 2.

 

 Select the patient name that contains the 1.
items to be imported into the active patient 

 

 Select the items to import from the list and 2.
click “Import” 

 

The palettes are now copied into the active 
patient. 

 

AUTO LOG SETTING 

This menu option is used to specify various 
vitals to be logged automatically after reaching 
a specific threshold. 
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A\V (Audio Video) 

GIGA is capable of interfacing with a number 
of third-party A/V recording systems. 
Generally, A/V solutions capture footage of the 
simulation and interlace it with the event 
information generated by the simulator control 
software. 

To enable the fetal Neo link menu option, go to 
Set Up > Options > Other and checkmark “Use 
AV System”. 

  

Click “Setup AV” to configure the software 
connection to the AV system. Enter a port 
number for the connection and click “Connect” 
to establish a link. Please contact the AV 
administrator for information on how to accept 
incoming connections from the GIGA software. 

 

Return to the A/V menu and click “Start AV” to 
initialize the recorder. Some third party A/V 
solutions may not recognize the “Start” 
command generated by the log event. If the 
recorder does not start remotely, please start 
the new video manually using the third party 
controls. 

The log event does not command the 
recording to stop at the end of the scenario 
automatically. Click Stop A/V from the menu to 
end the recording. 
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Help 

 

INSTRUCTION MANUAL 

Click the Instruction Manual option to open a 
digital copy of the latest “User Guide” 
information. 

ABOUT GUI 

Click “About GUI” to view the software version. 

 

CHECK FOR UPDATES 

Redistributable GIGA installer files are 
available for download at 
http://www.gaumard.com/software-updates/.  

To update the GIGA software using a flash 
drive: 

 Download the update file to a flash drive 1.
using a computer with internet access 

 Copy the setup file to the simulator’s 2.
control computer  

 Run the GIGA update file to update the 3.
software 

Do not change the wireless network 
settings. Doing so will disconnect the 
virtual monitor computer and the 
Gaumard Monitors vital signs software. 

To update the GIGA software using an 
Ethernet connection: 

 Connect an Ethernet cable to the laptop 4.
PC. 

 Click “Check for Updates”. 5.

 Click “Install” to begin the update. The 6.
download progress bar begins to auto-fill 
as the setup file is downloaded 

After the download is complete, the update 
setup wizard is launched automatically. 

 Click “Next”, and follow the wizard to 7.
complete the software download. 

DIAGNOSTICS 

The diagnostics menu is used to test the 
status of electronic and mechanical 
components in the simulator. 

Click “Check all Modules” to run a full systems 
check. Active modules report blue. Modules 
that are inactive or not installed report black. 
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Working with the 
Simulator 
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Overview 
Please reference the simulator model 
features list for detailed information on the 
standard and optional features for each HAL 
series model. 

AIRWAY & APPEARANCE 

 Intubatable airway and nares, 
accommodating most popular airway 
adjuncts 

 Difficult airway actuators for tongue 
edema, pharyngeal swelling, and 
laryngospasm 

 Visible and audible gastric inflation with 
esophageal intubation or upon forceful 
bag-valve-mask ventilation 

 Surgical site for tracheotomy, needle 
cricothyrotomy or retrograde intubation 

 Head tilt/ chin lift 

 Jaw thrust 

BREATHING 

 Control rate and depth of respiration and 
observe chest rise 

 Automatic chest rise is synchronized 
with respiratory patterns and lung 
sounds. 

 Select independent lung sounds: upper 
right front and back; upper left front and 
back; lower right front and back; lower 
left front and back 

 Accommodates assisted ventilation 
including BVM and mechanical support 

 Ventilations are measured and logged 

 Gastric distension with excessive BVM 
ventilation 

 Detection and logging of ventilations 
and compressions 

 Simulated spontaneous breathing 

 CO2 on exhalation (10 levels) using 
replaceable cartridge mounted inside 
the simulator 

 Variable respiratory rates and 
inspiratory/expiratory ratios 

 Attach to real mechanical ventilators 

 Bilateral chest rise and fall 

 Unilateral chest rise simulates 
pneumothoraces 

 Anterior and posterior auscultation sites 

 Bilateral needle decompression at 
second intercostal Dynamic Airway and 
Lung compliance/resistance 

 Ten levels of static compliance, 15-50 
ml/cm H2O 

 Ten levels of airway resistance 

 Use in conventional ventilation modes 

 Holds PEEP from 5 to 20 cmH2O 

 Exhales real and measurable CO2 

 Vary lung mechanics throughout 
scenario 

 Receive real time feedback from real 
mechanical ventilator 

 Capable of assisting the ventilator at 
variable respiratory rate 

CIRCULATION 

 Measure blood pressure by palpation or 
auscultation using a real BP cuff. 

 Korotkoff sounds audible between 
systolic and diastolic pressures 

 Oxygen saturation detected using a real 
monitor on the left index finger. 

 Pulse sites synchronized with BP and 
heart rate 

 Bilateral IV arms with fill/drain sites 

 Realistic flashback 

 SubQ and IM injection sites for 
placement exercises 

 Intraosseous access at tibia 

 Chest compressions generate palpable 
blood pressure wave form and ECG 
artifacts 

 ECG monitoring using real medical 
equipment 

 Defibrillate, cardiovert and pace using 
real devices 

 Multiple heart sounds, rates and 
intensities 

 ECG rhythms are generated in real time 

 Heart sounds synchronized with ECG 

 Dynamic 12 lead ECG display 

 Bilateral carotid, radial, brachial, 
femoral, popliteal and pedal pulses 
synchronized with ECG 

 Pulses vary with blood pressure, are 
continuous and synchronized with the 
ECG even during a paced rhythm 
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DRUG RECOGNITION SYSTEM 

 Simulator identifies drug type and 
volume injected into veins of the right 
hand and forearm 

 Supplied with 100 syringes having 
wireless tags 

 Use drugs from library or choose to 
model other drugs using software 
template 

 Physiologic models update simulated 
vital signs monitors 

 22 gauge needle recommended; larger 
needles will decrease venous life 

 Supplied with easily replaceable veins 

SPEECH 

 Wireless streaming audio 

 Pre-recorded sounds 

 Create and store vocal responses in any 
language 

 Be the voice of the simulator and hear 
responses at distances up to 100 
meters 

SYSTEMIC 

 Articulating body 

 Central cyanosis 

 Interchangeable genitalia 

 Auscultate bowel sounds 

 Catheterizable male/female genitalia 

 Blinking eyes with reactive pupils 

 Optional trauma amputation arm and/or 
leg 

 Seizure/convulsions 

 Supine or semi-recumbent positions 

VITAL SIGNS MONITOR 

 All in one touchscreen PC with virtual 
patient vital sign monitor software 

 Use selected configuration or create 
your own configuration to mimic the real 
monitors used in your facility 

 Customize alarms 

 Reflect simulator’s condition during the 
scenario 

 Share images such as ultrasounds, CT 
scans, lab results 

 Display up to 12 numeric parameters 

 Select up to 12 dynamic waveforms 

CONTROL 

 Proprietary communications module can 
be used simultaneously with the tablet 
computer's integrated wireless (IEEE 
802.11b) networking device 

 Bluetooth technology in the tablet 
computer allows wireless printing to 
compatible printer and quick 
connections to other devices 

 Touchscreen tablet with GIGA™ user 
interface 

 RF communications up to 300 meters in 
open space; streaming audio 100 
meters 

OTHER 

 One year limited warranty, available 
extended warranty to three years 

 Installation and training services 
available. 

 Technical support and onsite repair. 
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Features 
Disclaimer:  The section below describes all possible features in the HAL simulator. The content of 
this table is subject to change without prior notice. Please contact Gaumard Scientific for the most 
current information.  

Y = Yes included 
O = Optional 

Category Feature HAL
 
S3201 HAL

 
S3101 HAL

 
S3000 

Airway 

Nasal intubation Y Y Y 

Airway intubation Y Y Y 

Airway complications: pharyngeal swelling, 
laryngospasm and tongue edema 

Y Y Y 

Intubation Sensor Y Y Y 

Surgical Airway Y Y Y 

Airway sounds Y Y Y 

Breathing 

Respiratory patterns Y Y Y 

Independent quadrant lung sounds Y Y Y 

Hemothorax sites Y Y Y 

Needle decompression Y Y Y 

Bilateral chest rise Y Y Y 

Pulmonary ventilation Y Y Y 

Ventilations are measured and logged Y Y Y 

Monitor feedback on a real ventilator Y N N 

Bilateral bronchi resistance Y N N 

Breathing pattern triggers ventilator assist mode Y N N 

Variable lung compliance Y N N 

Real CO2 exhalation Y O N 

Cardiac 

Heart Sounds Y Y Y 

ECG Monitoring Y Y Y 

Electrical therapy Y Y Y 

12 Lead chest skin Y O O 

4 Lead chest skin - Y Y 

Circulation 

Bilateral pulses Y Y Y 

Bilateral IV arms Y Y Y 

Left arm blood pressure  

NIBP Y N N 

Manual Y Y O 

Modified N N Y 

Drug Recognition arm Y O O 
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Category Feature HAL
 
S3201 HAL

 
S3101 HAL

 
S3000 

Monitor OSAT using real monitor Y Y O 

Central cyanosis Y Y Y 

Neurological 

Reactive eyes Y Y Y 

Seizures Y Y Y 

Other 

CPR evaluation Y Y Y 

Intramuscular injection sites Y Y Y 

Urinary catheterization Y Y Y 

Intraosseous access Y Y O 

Bowel sounds Y Y Y 

Physiologic Modeling Y Y O 

Streaming audio Y Y O 

Virtual vital signs monitor Y O O 

Trauma leg O O O 

Trauma arm O O O 

Pro+ recording and debriefing solution O O O 
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Airway 

NASAL AND ORAL INTUBATION 

Intubate HAL’s airway via the nasal or oral 
route using an endotracheal tube or an LMA. 

WARNING: Always lubricate the 
endotracheal tube and the medical device 
using silicone oil before intubating. Do not 
introduce liquids into the airway. Doing so 
can permanently damage the system.  

Procedure 
Recommended Device 
Size 

Intubation (Blade 
size) 

Miller 4 or MAC 3.5 

LMA Size 4 

Nasal Intubation 
8 mm outer diameter 
max 

Oral Intubation ETT 7 or 7.5 

AIRWAY COMPLICATION 

Use the software controls to enable the airway 
complications and make intubation more 
difficult. HAL can display pharyngeal swelling, 
tongue edema, and laryngospasm. 

WARNING (S3201): Do not rotate the head 
while laryngospasm is on. Doing so may 
damage the laryngospasm mechanism. 

AIRWAY SOUNDS 

The simulator can produce audible airway 
sounds. Use the software controls to change 
the sound type and adjust the volume. 
Auscultate using a standard stethoscope. 

INTUBATION SENSOR 

Sensors in the airway detect the placement of 
the endotracheal tube. If the endotracheal tube 
is inserted too deep, the left lung is disabled 
automatically demonstrating right mainstem 
intubation. Correcting the tube position 
enables the left lung chest rise. 

SURGICAL AIRWAY 

HAL includes replaceable surgical airway 
inserts that allow for tracheotomy or needle 
cricothyrotomy exercises using real medical 
equipment. The surgical inserts feature 
anatomical landmarks. A separate ventilation 
insert is pre-installed designed to maintain a 
tight air seal during ventilation and intubation 
exercises. Interchange the airway inserts as 
needed. For more information on consumable 
items, navigate to page Error! Bookmark not 
defined.. 

WARNING: Do not perform surgical 
exercises on the ventilation insert. 

 

SURGICAL INSERT INSTALLATION 

To remove the ventilation insert and install a 
surgical insert: 

1. Remove the ventilation airway insert by 
pulling on the ribbons located on either 
side. 
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The airway ventilation insert is marked by a 
blue dot on either side. 

 

2. Adjust the ribbons to accommodate the 
surgical neck insert. 

 

3. Apply petroleum jelly to all four sides of 
the surgical insert. The letter T (top) 
indicates the orientation of the insert’s 
placement. 

 

4. Place the surgical insert inside the cavity 
with the letter T towards the head and 
gently press it down into position.  

 

5. Feel the anatomical landmarks to identify 
the surgical insert. 
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Breathing 

BILATERAL CHEST RISE 

Bilateral chest rise and fall is automatic. Use 
the software controls to enable or disable the 
lungs independently and to adjust the 
breathing rate and the inspiratory percentage. 

VENTILATION 

Set the respiratory rate to 0 and ventilate the 
simulator using a standard bag valve mask. 
Open the CPR window to monitor the 
provider’s ventilation performance in real time. 
Complete the ventilation calibration process 
before using the ventilation feature for the first 
time. 

VENTILATION CALIBRATION 

The ventilation calibration wizard records the 
performance average of five ventilations as the 
benchmark for correct ventilation. Perform the 
actions requested by the calibration wizard 
following the most current CPR guidelines. 
The CPR window evaluates provider 
performance based on the benchmark 
recorded during the calibration process. 

To calibrate the ventilation performance 
benchmark: 

 Click Setup > Calibration > Ventilations, 1.
and click “Next” 

The wizard prompts to perform ventilation “#1” 

 Perform the first ventilation. A green filled 2.
oval indicates that the ventilation was 
recorded successfully 

 Perform ventilation # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the ventilation was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five ventilations 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 

BREATHING PATTERNS 

Control the respiratory rate, pattern, and 
inspiration percentage using the software 
controls. The breathing patterns are 
synchronized with the lung sounds and chest 
rise. 

DYNAMIC LUNG (S3201) 

HAL’s dynamic lungs can simulate the elastic 
properties of a real human lung. The 
adjustable lung properties allow for simulating 
a variety of respiratory complications. 
Participants can connect HAL to a mechanical 
ventilator using standard medical procedures 
and monitor realistic waveform feedback on 
the ventilator screen. Adjust the lung 
parameters and the vital signs to improve or 
deteriorate HAL’s condition throughout the 
simulation. 

 

Some of HAL’s dynamic lung features include: 

 Connect HAL to a mechanical ventilator 
directly using a standard ventilator circuit 
just like a real patient. No proprietary 
adjuncts, adapters, or intermediary 
devices are required to connect a 
ventilator to the simulator. 

 Provide mechanical ventilation by volume 
or pressure 

 Provide mechanical ventilation with assist 
control and other modern ventilation 
modes 

 Use the GIGA controls to adjust HAL’s 
dynamic lung properties on the fly while 
the simulator is connected to the 
ventilator. 

 Adjust HAL’s ten static lung compliance 
levels (from 15 to 90 mL/cm H2O) and ten 
levels of independently controlled airway 
resistance to deteriorate or improve HAL’s 
condition during the scenario 

 HAL holds positive end-expiratory 
pressure (PEEP 2 - 50 cm H2O ) even 
while lung compliance and airway 
resistance levels undergo a change 

 Set HAL’s inspiratory effort rate to trigger 
the ventilator for an assisted breath 
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DISCLAIMER: HAL’s operating limitations 
are consistent with that of a real person. 
Treating HAL in a manner that would 
seriously harm a real person is likely to 
result in damage to the internal lung 
system.  

DISCLAIMER: HAL is not designed to test 
the performance, functionality, and 
accuracy of a mechanical ventilator. 
Always follow the mechanical ventilator’s 
guidelines and precautions. 

WARNING: Do not introduce liquids, 
humidified gases, or administer aerosol 
medications into the airway. Moisture in the 
airway will damage the simulator’s internal 
mechanics. 

INSTRUCTIONS FOR USE 

By default, HAL will initialize with healthy 
respiratory rate of 13 breaths per minute. 
Connecting the ventilator while the simulator is 
breathing normally is not recommended. Just 
as with a real patient, attempting to force air 
into the airway while Hal is breathing normally 
will likely trigger the ventilator alarms and put 
unnecessary stress on the lungs. 

Avoid intubating the airway while the 
simulator is powered off. Doing so will 
result in inaccurate intubation readings. 
To reset the intubation sensor, remove 
the ET tube and restart the software.  

To connect HAL to a mechanical ventilator and 
start assisted ventilation: 

1. Using the GIGA software controls, set 
HAL’s respiratory rate to 0 

2. For this example, configure the ventilator 
with the following settings (suggested): 
breaths per minute frequency: 12-15 bpm,  
max flow rate 40 L/min, tidal volume 550 
mL, patient weight: 75 Kg (165 lbs.), 
ventilation control by Volume. 

3. On the GIGA software, toggle the 
simulator’s lung compliance mode setting 
to “V” (Adjust lung compliance by 
Volume). If the ventilator is set to pressure 
control, set the GIGA lung compliance 
mode to “P” (adjust lung compliance by 
pressure) 

 

4. Lubricate the endotracheal tube and 
intubate HAL. Placement procedures and 
tube sizes follow the specifications of an 
adult patient. 

5. Connect the ventilator to the patient circuit 
and initialize the ventilator 

Please allow up to 60 seconds while HAL’s 
dynamic lung properties stabilize.  

ADJUSTING THE DYNAMIC LUNG 
CONTROLS 

Use the following GIGA controls adjust the 
simulator’s dynamic lung properties. After 
making a change to a lung parameter (lung 
compliance and resistance), please allow up to 
60 seconds for the lungs properties to stabilize 
at the new static level. Avoid adjusting the 
ventilator settings during the brief stabilization 
period. All other vital signs parameters will 
continue to trend as specified. 

 Lung compliance: Change the lung 
compliance level to adjust HAL’s lung 
elasticity. Increase the lung 
compliance to level 9 to make the 
lungs more flexible. Decrease the 
lung compliance to level 1 to make 
the lungs more rigid.  

 Resistance: Adjust the “resistance” 
control to increase or decrease the 
resistance to airflow during ventilation 
and exhalation for each lung.  

 Patient Trigger Rate: Adjust the 
“patient trigger rate control” to set the 
number of inspiratory efforts HAL will 
make in 1 minute. The patient trigger 
rate programs HAL to inspire 
periodically to simulate a real patient 
attempting to take a breath. Each 
inspiratory effort can trigger a 
ventilator’s assist mode to deliver a 
full assisted breath or a spontaneous 
breath on CPAP. 
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RESPIRATORY SOUNDS 

The simulator is generates audible upper, 
lower, anterior, and posterior lung sounds. Use 
the software controls to select between the 
available respiratory sounds and to adjust the 
volume of each lung independently. The 
respiratory sounds include normal, wheezing, 
inspiratory squeaks, crackles, and rales. 

HEMOTHORAX SITES 

Bilateral chest drain sites located in the 5
th

 
intercostal space allow for Pneumo or 
hemothorax exercises. The hemothorax sites 
support 32 French straight thoracic catheters 
only. 

WARNING: Use the hemothorax sites for 
placement exercises only. Do not introduce 
fluid to the hemothorax sites. 

 

NEEDLE DECOMPRESSION 
Bilateral needle decompression sites are 
located at the second intercostal space. To 
build up pressure in the pleural space, turn the 
pneumothorax feature on using the software 
controls. Treat the tension pneumothorax 
using a needle. Then, turn the pneumothorax 
feature off to stop the flow of air through the 
decompression site. Use smaller gauge 
needles to extend the life of the chest skin and 
the needle decompression reservoirs. 

 

REAL CO2 EXHALATION 

HAL can exhale real CO2 with the use of a 
CO2 cartridge. Once a CO2 cartridge is 
installed in the simulator, use the software 
controls to adjust volume of CO2 exhaled. HAL 
can also be operated without a CO2 cartridge 
installed. A virtual CO2 value is displayed on 
the virtual monitor PC. 

Due to shipping regulations, CO2 cartridges 
are not included with the system. The required 
16g threaded CO2 3/8”-24UNF-2A cartridges 
can be purchased at most bicycle or hardware 
stores. 12g threaded cartridges are also 
compatible with the CO2 feature. 
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CO2 SAFETY AND WARNING 
CHECKLIST 

Review the safety and warning checklist 
information before using the CO2 feature. 
Failure to comply with the warnings listed 
below and those included with the original 
cartridge packaging may result in serious 
personal injury.  

 Always follow the manufacturer’s 
safety and warning information 
included with the CO2 cartridge 
package. 

 Never point a CO2 cartridge at 
yourself or others 

 Do not use damaged CO2 cartridges 

 Do not puncture the cartridge CO2 
seal manually 

 Do not expose the CO2 cartridges to 
high temperatures as indicated on the 
product’s packaging 

 Install threaded cartridges only (3/8”-
24UNF-2A). Do not attempt to install 
a cartridge that does not meet the 
specifications listed in this document. 

 Do not over tighten the cartridge into 
the simulator’s cartridge harness 

 Always verify that the CO2 cartridge 
is empty using the software 
diagnostics before removing it. Do not 
remove the CO2 cartridge if the 
simulator is not fully operational.  

INSTRUCTIONS FOR USE 

For maximum duration, connect the CO2 
cartridge just before the simulation begins. If a 
CO2  cartridge is installed and left overnight, it 
will empty within 24 hrs whether it is used or 
not. 

To install a new CO2 cartridge: 

1. Remove the right leg skin cover and the 
tibia bone insert 

 

2. Remove the harness adapter located 
inside the right lower leg chamber.  

 

3. Screw in a new CO2 cartridge into the 
harness adapter. The harness adapter will 
puncture the CO2 seal as the cartridge is 
tightened. The cartridge will feel cool to 
the touch when the seal is broken. 
Continue to tighten the CO2 cartridge until 
is secured.  

Do not unscrew the cartridge once the seal 
is broken. 

 

4. Insert the adapter into the chamber and 
replace the tibia insert and skin. 
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ADJUSTING CO2 OUTPUT 

After the cartridge installed, adjust the Lung 
CO2 parameter to adjust the volume of 
exhaled CO2. 

 

The graph below outlines the duration of CO2 
output for each of the programmable CO2 
levels with following parameters: RR=13, 
Compliance= 8, Airway Resistance=0, VT = 
550. Go to page 119 for information on 
installing the CO2 cartridge. 

CO2 
Level 

Approximate 
kPa 

Approximate 
duration (in 
minutes) of CO2  

0 0  

1 1.7 125 

2 2.8 110 

3 3.9 75 

4 4.7 55 

5 5.5 45 

6 6 35 

7 6.7 30 

8 7.3 25 

9 7.7 25 

10 8.5 20 

 

REMOVING AN EMPTY CO2 
CARTRIDGE 

A “Low CO2!” notification is displayed when 
low CO2 pressure is detected in the cartridge.   

 

Go to Setup> Calibration> Factory Settings 
and click “CO2 Pressure” to view the cartridge 
pressure reading. Replace the CO2 cartridge 
when the pressure reading reports 0.0 psi.  

Do not remove the cartridge if pressurized 
CO2 is being reported. Allow the CO2 
cartridge to empty before attempting to 
remove it. 

 

Unscrew the empty CO2 cartridge slowly. If 
CO2 starts to escape, STOP unscrewing the 
cartridge and allow the remaining CO2 to 
escape before removing the cartridge 
completely. 

WARNING: Never point the CO2 cartridge 
at yourself or others. 
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Cardiac 

HEART SOUNDS 

HAL generates audible heart sounds (normal, 
distant, systolic murmur, S3 and S4) which are 
tied to a user defined heart rate and selectable 
rhythms. Use the software controls to change 
the heart sound type and volume level. 

ECG MONITORING AND 
ELECTRICAL THERAPY 

The simulator is equipped with conductive skin 
sites that allow the attachment of real 
electrodes and defibrillator pads. This feature 
allows the provider to track cardiac rhythms 
using real medical equipment just like with a 
human patient.  

The simulator’s ECG and defibrillation sites 
generate waveforms detectable using real 
medical equipment and standard electrodes. 
Real automated external defibrillators can 
detect the simulator’s heart rhythm and treat 
shockable rhythms.  

Defibrillation is only supported on the large 
sternum and apex sites circled RED below. 
Do not deliver a shock to ECG electrode 
sites on the shoulders or waist marked 
GREEN. The warranty does not cover 
damaged to the simulator caused by 
applying electrical therapy to the ECG 
sites. 

For exercises that incorporate real 
electrical therapy of any kind, always follow 
the safety guidelines and operating 
procedures outlined in the medical device 
manufacturer documentation. 

12 LEAD CHEST SKIN 

 

4 LEAD CHEST SKIN 

 

ECG AND ELECTRICAL THERAPY 
CHECKLIST AND WARNINGS 

 Always follow the standard medical 
guidelines and precautions for handling 
electrical therapy devices. Improper use of 
a real electrical therapy device may result 
in personal injury. 

 Operate simulator in a well-ventilated area 
free of flammable gases. 

 Ensure the simulator is fully assembled, 
fully operational, dry, and undamaged 
before administering electrical therapy. 
Never apply electrical therapy if the 
simulator is in contact with a conductive 
surface or substance. 

 Do not leave electrodes or pads attached 
to the conductive sites when the simulator 
is not in use. 

 Use hard paddles or wet-gel pads 
preferably. Avoid using solid-gel pads as 
they increase the risk of burning the 
simulator’s skin if arcing occurs. When 
using gel patches, make sure not to leave 
air gaps or bubbles between the pads and 
the conductive area on the simulator’s 
skin to avoid arcing. 

 Clean the conductive sites at the end of 
the simulation. Refer to the care section 
for more information on approved cleaning 
products. Gel residue, adhesive residue, 
or dirt can increase the risk of arcing 
during defibrillation. 

 Do not reused gel-adhesive or use 
expired pads. 
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 Do not attempt to repair or modify any 
electrical connections or conductive sites. 
Discontinue use if wires are exposed, wire 
insulation is damaged, or if any 
conductive sites are damaged. 

 Electrode gel can become a pathway for 
electrical current. Do not allow 
defibrillation pads to overlap ECG sites or 
gel to carry a current to the ECG sites. 
Applying an electrical current to the ECG 
sites will result in damage to the 
simulator’s internal components. 

 Some electrical therapy devices may be 
sensitive enough to detect the simulator’s 
electrical current for operation. If the 
interference is displayed on the ECG 
reading, please disconnect simulator’s 
charger and operate the simulator on 
battery power only. 

CHEST COMPRESSIONS 

Set the heart rhythm to asystole and instruct 
the provider to perform chest compressions. 
Monitor the depth and frequency of chest 
compressions from the CPR trainer window. 
Before using the chest compression feature for 
the first time, please calibrate the chest 
compression feature.  

COMPRESSION CALIBRATION 

The compression calibration wizard records 
the performance average of five compressions 
as the benchmark for a correct compression. 
Perform the actions requested by the 
calibration wizard following the most current 
CPR guidelines. The CPR window evaluates 
provider performance based on the benchmark 
recorded during the calibration process. 

To calibrate the compression performance 
benchmark: 

 Click Setup > Calibration > Compressions, 1.
and click “Next” 

The wizard prompts to perform compression 
“#1” 

 Perform the first compression. A green 2.
filled oval indicates that the compression 
was recorded successfully 

 Perform compression # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the compression was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five compressions 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 
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Circulation 

BILATERAL PULSES 

The simulator’s palpable pulses are blood 
pressure dependent. Use the software controls 
to disable the distal pulses to simulate severe 
hypotension. 

Non-Invasive Blood Pressure (S3201 
H1209613 OR HIGHER) 

HAL’s upper left arm can generate palpable 
oscillations that simulate blood flow. This 
allows care providers to monitor HAL’s blood 
pressure using a non-invasive blood pressure 
cuff and oscillometric monitoring equipment. 

Complete the NIBP calibration process before 
using the feature for the first time. The NIBP 
feature is calibrated to work with one cuff at a 
time.  

NIBP Cuff Size Adult Large 

ENABLING THE NIBP FEATURE 

To enable the NIBP feature, go to 
Setup>Options>Hal Add-ons tab and 
checkmark “Use automatic NIBP”. 

Enabling the automatic NIBP function 
disables the manual blood pressure 
method feature. 

NIBP CALIBRATION 

Locate the “NIBP Calibration KIT” and follow 
the steps below to connect the kit bulb to the 
NIBP cuff line. The kit bulb is used to set the 
NIBP cuff pressure to the pressure intervals 
requested by the blood pressure calibration 
wizard. 

  

To setup the NIBP cuff for calibration using the 
NIBP calibration kit: 

1. Disconnect the NIBP cuff from the 
monitoring equipment. 

2. Connect the kit bulb included with the 
“NIBP calibration kit” to the NIBP cuff line. 
The kit adapters included fit a number of 
different type of connectors found on most 
NIBP cuffs as seen below. 

NIBP connector type 1 

  

NIBP connector type 2 
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NIBP connector type 3 

   

3. Place the NIBP cuff on the left arm 
following the placement techniques used 
on a real human patient.  

4. Leave the cuff on the arm and calibrate 
the blood pressure feature using the 
software blood pressure calibration wizard 
and the kit pressure bulb.  

5. After the calibration process is complete, 
disconnect the calibration kit and connect 
the cuff to the electronic automatic blood 
pressure monitor. 

It is recommended that the NIBP cuff stays 
placed on the arm after the calibration process 
is complete. Removing and replacing the NIBP 
cuff on the arm can affect the accuracy of the 
readings. If the cuff must be placed on the 
simulator as part of the exercise, the provider 
should place the cuff on the arm in the same 
location it was placed during calibration 
process. 

BLOOD PRESSURE (MANUAL) 

Measure the blood pressure using a standard 
sphygmomanometer. Korotkoff sounds are 
heard between systolic and diastolic pressure 
readings. Before using the blood pressure 
feature for the first time, place the blood 
pressure cuff on the arm and calibrate the 
blood pressure feature using the blood 
pressure calibration wizard. 

To enable the manual BP feature, go to 
Setup>Options>Hal Add-ons tab and 
uncheck “Use automatic NIBP”. 
Enabling the automatic NIBP function 
disables the manual blood pressure 
method feature. 

INSTRUCTIONS FOR USE 

 Place the cuff around the simulator’s 1.
upper left arm with the cuff mark at the 
medial site of the bicep brachii, about an 
inch (two cm) above the anterior elbow. 

Place the cuff in the same position used 
during the calibration process for 
accurate readings. 

 Inflate the BP cuff, and auscultate 2.
Korotkoff sounds just as with normal 
patient. 

MODIFIED BP PORT FOR VIRTUAL 
BP SYSTEM (HAL S3000) 

Connect the modified blood pressure line to 
the port on the simulator’s left shoulder. Before 
using the blood pressure feature for the first 
time, place the blood pressure cuff on the arm 
and calibrate the blood pressure feature using 
the blood pressure calibration wizard. 
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BLOOD PRESSURE CALIBRATION 
WIZARD 

Before starting the calibration process, place 
the blood pressure cuff on the simulator as it 
would be placed on a real human patient. 

To calibrate the blood pressure feature: 

1. Click Setup>Calibration>Blood pressure 
and click “Next” 

2. Set the pressure on the BP cuff to 0 (i.e. 
cuff valve open) as prompted by the 
calibration wizard. 

3. Click the “OK” button to record the current 
cuff pressure for the interval. A green filled 
oval indicates the pressure interval was 
recorded successfully.  

4. Set the pressure on the BP cuff to 20 
mmHg as prompted by the wizard and 
then Click “OK” to record. 

5. Continue increasing the BP cuff pressure 
as indicated by the prompt and recording 
the pressure intervals. 

At the end of the calibration wizard, click 
“Finish” to close the calibration wizard. 

DRUG RECOGNITION (OPTION) 

The drug recognition feature enhances the 
realism of intravenous drug administration 
exercises by using tagged syringes 
programmed with virtual medications. During 
an IV push administration exercise, the drug 
recognition system can detect the virtual 
medication injected, the dosage infused, and 
the administration rate in real time. This allows 
GIGA to adjust the patient’s vital signs in 
response to the virtual medication infused 
automatically. For more information on 
monitoring medications infused into the drug 
recognition arm, go to page 88. 

The drug recognition arm can be identified by 
the black drainage port located on the right 
forearm. 

WARNING: The simulator must be on 
when introducing fluids into the drug 
recognition arm. This includes calibration, 
purging, draining, IV infusion, and injecting 
fluids into the veins or the filling ports. 
Introducing fluids into the drug recognition 
arm while the simulator is off will damage 
the arm and the simulator. Damage caused 
by improper use is not covered under 
warranty. 

The drug recognition arm is equipped with 
a black drain port and a white filling port. 
Do not reverse the ports while introducing 
fluids into the system; doing so will 
damage the system. Do not attempt to fill 
the IV system without the black drain 
connector in place. Always leave the black 
drain port connected during high volume 
infusions. 

PRIMING THE DRUG 
RECOGNITION ARM 

The drug recognition sensors are active only 
when fluid is present in the vasculature. Prime 
the drug recognition arm by filling the forearm 
vasculature with fluid. This process should be 
completed before simulation begins. 

The drug recognition arm is equipped with a 
black port for draining and a white port for 
filling. Do not reverse the ports while 
introducing fluids into the arm; doing so will 
damage the system. 

Locate the IV Filling kit, which includes the 
drainage tube (black tip) and filling tube (white 
tip) and filling syringe. 

WARNING: Use only Gaumard’s artificial 
blood concentrate or clean water to fill the 
vasculature. Any other simulated blood 
brand containing sugar or any additive may 
cause blockage and/or interruption of the 
vasculature system. 

To prime the drug recognition arm for an IV 
push exercise: 

 Power on the simulator 1.

 Attach the drain tube to the black output 2.
port and place the end of the drain hose 
inside a container. 
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Place the collection container below the 
arm level to siphon the fluids in the next 
step. 

 Fill the filling syringe with water and 3.
connect it to the white port. 

 Insert water in the system until fluids exit 4.
through the drainage tube and all air 
bubbles are purged. 

 Disconnect the drain tube and the fill 5.
syringe. 

PROGRAMMING THE SYRINGES 

The tagged syringes supplied with the Drug 
Recognition arm must be associated with a 
virtual medication and a concentration before 
they are used for the first time. The syringes 
remain programmed unless the medication 
properties are deleted manually using the “Set 
Med ID” menu.  

To program a tagged syringe with a virtual 
medication for use with the drug recognition 
arm: 

 Power on the simulator  1.

 From the Setup menu, click “Set Med ID”. 2.
The Set Med Id option is only available on 
simulators equipped with the Drug 
Recognition Arm. 

The Set Medication Identifier dialog box is 
displayed.  

 

 Rotate the lower right arm so the palm of 3.
the hand is facing up, and place the 
syringe holder on the simulator’s right 
wrist.  

 

 Place the tagged syringe in the holder. 4.
The syringe must be perpendicular to the 
surface of the forearm. 

 

 Select a drug from the drop-down menu 5.
and enter the concentration. 
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The Syringe Identifier displays “Ready!” when 
the syringe is in range. 

 Click the “Add” button associate the virtual 1.
medication to the syringe. Please wait 
while process is completed. 

 

The syringe is now associated with the 
medication type and concentration. The 
medication association is listed in the “Set 
Medication Identifier” dialog box. Use the 
labels provided to identify the syringe with the 
medication name and concentration. 

Repeat the “Set Med ID” process to program 
additional syringes with other medications.  

Reuse tagged syringes by reprogramming the 
associations. To delete a medication 
associated with a particular syringe, highlight 
the desired medication from the “Set Med ID” 
list and click “Delete Selected Medication” 
button.  

The medication detection feature can trigger 
auto responses. Drug auto responses move 
the scenario to the next stage when the drug 
type and dosage threshold are detected. To 
learn more about programming drug auto 
responses in a scenario, go to page 57. . 

INSTRUCTIONS FOR USE 

To inject fluids into the drug recognition (right) 
arm using a tagged syringe: 

 Power on the simulator and select the 1.
Automatic operating mode  

 Fill the preprogrammed syringe with fluid. 2.

 Inject a vein on the anterior or posterior 3.
right forearm while maintaining the syringe 
near the arm. 

The tagged syringe must be close to the arm 
for the drug recognition module to detect the 
medication type. 

WARNING 

Maximum amount of fluid injected without 
draining should not exceed 40 mL and the 
maximum injection rate is 9999 mL/hr. 

IV ARM 

The simulator is equipped with an IV arm that 
allows for bolus or intravenous infusions as 
well as for drawing fluids. 

WARNING 

The drug recognition arm is equipped with 
a black drainage port. Reversing the fill 
and drain connections on a drug 
recognition arm will damage the system 
and void the warranty. Please refer to the 
Drug Recognition section to prime the drug 
recognition arm for an exercise. 

Do not attempt to fill IV system without the 
drain connector in place. 

Always leave the drain port connected 
when injecting fluids into the system. 

Use only Gaumard’s artificial blood 
concentrate or clean water to fill the 
vasculature. Any other simulated blood 
brand containing sugar or any additive may 
cause blockage and/or interruption of the 
vasculature system. 

Always flush the IV system with distilled 
water at the end of every simulation. 

INSTRUCTIONS FOR USE 

To prime the IV arm for an infusion exercise or 
to draw fluids: 

 Locate the fill syringe with tubing and the 1.
drain tube with pinch-clamp. Fill the 
syringe with the desired fluid -- water or 
simulated blood. 
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 Connect the syringe with tubing to one 2.
port and the drain tube with clamp to the 
other port as shown. 

 

 Insert water in the system until fluids exits 3.
through the drainage tube into the 
container and all air bubbles are purged. 

 

The IV arm is now ready for use. 

To simulate a patient with no accessible 
peripheral IV sites, connect only the syringe. 
Pull the plunger to create suction, which will 
collapse the veins. Disconnect the syringe 
tube from the arm port while maintaining 
suction. The port will seal, and the veins will 
remain collapsed. 

CLEANING THE VASCULATURE 

Clean and dry the forearm vasculature at the 
end of the simulation session to prevent mold 
or clogs. 

To clean and dry the IV arm: 

 Power on the simulator  1.

 Fill the filling syringe with distilled water 2.

 Connect the fill syringe and the drain tube 3.
to arm 

 Flush the vasculature with distilled water. 4.
If the IV arm is not going to be used for a 
week or more, purge the system with 70% 
isopropyl alcohol solution. 

 Fill the filling syringe with air and purge 5.
the clean water to dry the vasculature. 

 Disconnect the drain tube and filling 6.
syringe 

Warning: 

Do not store the simulator with fluids in the 
veins. Doing so may lead to molding and 
damage to the internal electronics. 
Complete the vasculature cleaning 
procedure at the end of the simulation 
sessions. 

OXYGEN SATURATION 

Use a real oxygen saturation monitor to get an 
oxygen saturation reading from the left index 
finger. Before using the oxygen saturation 
feature for the first time, calibrate the simulator 
to work with the oxygen saturation monitor to 
be used during the exercise.  

 

OXYGEN SATURATION 
CALIBRATION 

GIGA stores the calibration settings for one 
device at a time. If the oxygen saturation 
monitor or the sensor is changed, the 
simulator must be recalibrated to work with the 
new device. 

Disclaimer: Oxygen saturation monitors 
that detect carbon monoxide and/or 
methemoglobin are not supported. 

To calibrate the oxygen saturation finger: 

 Turn OFF the oxygen saturation monitor 1.
and place the oximeter sensor on the left 
index finger. Verify that the left index 
finger is centered inside the finger sensor. 

 Go to Setup>Calibration and select 2.
“Oxygen Saturation”. Click “Next” to 
continue. 

 Turn ON the oximeter and click “OK” on 3.
the dialog box. 
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 Adjust the reading on the oximeter 4.
monitor screen to match the value 
displayed on the GaumardUI calibration 
screen using the arrows on the left column 
of the calibration window. The first 
calibration point is 98%. 

Use the triple arrows to increase or decrease 
the reading on the oximeter in large intervals, 
double arrows for moderate changes, and the 
single arrows for small changes of one or two 
percent readings. Wait 10-15 seconds after 
making an adjustment to allow the oximeter 
reading to stabilize. Doing so ensures proper 
calibration. 

 After the reading on the OSAT monitor is 5.
stable and it matches the value on the 
GaumardUI calibration window, click “OK”, 
and then “Next” to continue. 

 Repeat the process to calibrate the 6.
following intervals. 

 Click “Finish” at the end of the calibration 7.
and remove the OSAT monitor from the 
finger. 

INSTRUCTIONS FOR USE 

 Start GIGA and establish communication 1.
with the simulator. 

 Connect the oximeter probe to the left 2.
index finger of the simulator. 

 Turn on the monitor. 3.

 Adjust the oxygen saturation using the 4.
GIGA software controls. 

CENTRAL CYANOSIS 

Use the software controls to adjust the 
cyanosis intensity.  
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Neurologic 

REACTIVE EYES 

The simulator is equipped with programmable 
blinking eyes and pupils that dilate. Use the 
software controls to change the blinking rate 
and to enable or disable pupil reaction. 

PUPIL CALIBRATION 

The eye reaction is factory calibrated. Use the 
“Pupil Sensitivity” controls to recalibrate the 
pupil reaction for the current room lighting only 
if needed. 

To calibrate the pupil dilation: 

1. From the File menu, go to 
Setup>Options>Tolerances 

2. Click “Set ambient light” to recalibrate the 
pupil diameter to the current ambient light. 

3. Cover both eyes from most incoming light 
and click "Set Dilation Light" to set the low 
light pupil diameter. 

4. Click increase or decrease to adjust the 
pupil’s sensitivity to light 

SEIZURES 

The simulator is capable of convulsing to 
simulate mild or severe seizures. Use the 
software controls to enable the seizure 
behavior. 
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Other 

BOWEL SOUNDS 

Use the bowel sound controls to change the 
bowel sound types and adjust the volume 
levels. Auscultate the bowel sounds using a 
real stethoscope. 

GASTRIC DISTENSION 

HAL can exhibit gastric distension if ventilated 
excessively. To relieve the gastric distension, 
press down on the stomach gently. 

INTRAMUSCULAR INJECTION 
SITES 

Intramuscular injection sites are located on 
both deltoids and quadriceps for injection 
technique and placement exercises. 

INTRAOSSEOUS ACCESS 

HAL features replaceable tibia bones on the 
left leg for intraosseous access. The hollow 
bones allow for the aspiration and infusion of 
fluid using real medical devices.  

To fill the tibia bones with fluid: 

1. Remove the skin cover from the right leg 
to access the two-part tibia. 

2. Remove lower half of the tibia. 

 

3. Fill the tibial tuberosity with fluid using the 
filling syringe. 

 

4. Fill the tibia fluid using the filling syringe. 

 

5. Replace tibia bone in the leg and the skin 
cover. 

INSTRUCTIONS FOR  USE 

Intraosseous access is allowed in the hollow 
tibia inserts only. To view a list of replacement 
parts including leg skin covers and tibia bones, 
go to page Error! Bookmark not defined.. 

RESUSCITATION (CPR) 

The simulator features ventilation and 
compression sensors for monitoring CPR 
performance. The CPR window detects 
ventilations when the respiratory rate is set to 
zero or apneic and compressions when the 
heart rhythm is in an unhealthy state.  

Complete the ventilation and compression 
calibration process before using the CPR 
window for the first time. To learn more about 
the CPR window, go to page 91. 

VENTILATION CALIBRATION 

The ventilation calibration wizard records the 
average performance of five ventilations as a 
benchmark for a correct ventilation. Perform 
the actions requested by the calibration wizard 
following the most current CPR guidelines. 
The CPR window evaluates provider 
performance based on the benchmark 
recorded during the calibration process. 

To calibrate the ventilation performance 
benchmark: 

 Click Setup > Calibration > Ventilations, 1.
and click “Next” 

The wizard prompts to perform ventilation “#1” 

 Perform the first ventilation. A green filled 2.
oval indicates that the ventilation was 
recorded successfully 
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 Perform ventilation # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the ventilation was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five ventilations 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 

COMPRESSION CALIBRATION 

The compression calibration wizard records 
the average performance of five compressions 
as a benchmark for a correct compression. 
Perform the actions requested by the 
calibration wizard following the most current 
CPR guidelines. The CPR window evaluates 
provider performance based on the benchmark 
recorded during the calibration process. 

To calibrate the compression performance 
benchmark: 

 Click Setup > Calibration > Compressions, 1.
and click “Next” 

The wizard prompts to perform compression 
“#1” 

 Perform the first compression. A green 2.
filled oval indicates that the compression 
was recorded successfully 

 Perform compression # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the compression was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five compressions 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 

STREAMING AUDIO 

Use the streaming voice to speak as the 
simulator’s voice and engage the provider in a 
realistic conversation.  

INSTRUCTIONS FOR USE 

Ensure that the headset and microphone is 
connected to the PC before starting the GIGA 
software. The headset minimizes echo and 
environmental noise to improve audio quality. 

 

 

Click the “talk” icon and speak in to the 
headset to talk as the simulator’s voice. 
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To listen to the provider’s response, click 
“Listen”. 

 

Reference the GIGA software User Guide for 
information on additional streaming voice 
features and functions. 

TRAUMA LIMBS 

Enhance the realism of a trauma scenario by 
installing the trauma leg and trauma arm. The 
interchangeable trauma limbs feature pulsatile 
bleeding from major arteries consistent with 
the heart rate and blood pressure. In addition, 
providers can apply a tourniquet on the limb to 
reduce the bleeding. 

 

 

TRAUMA LEG INSTALLATION 

To install the trauma leg: 

5. Power the simulator off or set it to standby 

6. Remove the knee bolt and gently separate 
the lower leg to expose the pulse tube and 
power cable. 

 

7. Disconnect the leads from the normal leg 
and secure the pulse and power 
connections to the trauma leg.  

 

8. Attach and secure amputated lower leg 
using the original knee bolt. 

TRAUMA ARM INSTALLATION 

To install the trauma arm: 

1. Power the simulator off or set it to standby 
mode 

2. Remove the elbow bolt from the left arm 
and gently separate the lower arm to 
expose the pulse tubing and power 
connection. 

3. Disconnect the pulse lead. 
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4. Connect the red pulse tube and black 
power cable and screw the trauma arm 
onto the elbow joint. 

 

FILLING THE TRAUMA LIMB 

To fill the trauma limb with simulated blood: 

1. Connect an empty 50 cc fill syringe to the 
blood reservoir port located on the trauma 
limb and vacuum the air inside. 

2. Fill the filling syringe with Gaumard’s 
simulated blood. 

WARNING: Use only simulated blood 
provided by Gaumard. Any other simulated 
blood brand containing sugar or any 
additive may cause blockage and/or 
interruption of the vasculature system. 

3. Connect the filling syringe with simulated 
blood to the blood reservoir port and inject 
fluid into the reservoir. Do not overfill the 
reservoir. 

Trauma arm 
reservoir capacity 

120 mL. 

Trauma leg reservoir 
capacity 

500 mL. 

INSTRUCTIONS FOR USE 

Once the trauma limbs are installed and the 
reservoirs are filled with fluid, set the trauma 
controls to ON to start the blood flow from the 
severed arteries. 

 

 

URINARY CATHETERIZATION 

HAL features an internal bladder used for 
catheterization exercises.  

Bladder reservoir 
capacity 

240 mL 

Urinary Catheter 18 Fr catheter 

To fill the bladder with fluid to perform a 
catheterization exercise: 

1. Unfasten the mid-section skin from the left 
and ride side. 

 

2. Connect the IV fill Syringe to the one way 
valve located on the right side of the 
simulator. 
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3. Fill the bladder bag with a maximum 
volume of 240 mL 

 

4. Remove the syringe and re attach the 
midsection skin.  

INTERCHANGEABLE GENITALIA 

The simulator features interchangeable male 
and female genitalia.  

To install the male genitalia: 

1. Remove the female catheter adapter. 

 

2. Insert the male genitalia urethra tube into 
the catheter port. Ensure the connector is 
secured to prevent leaks. 

 

INSTRUCTIONS FOR USE 

Catheterize the simulator using an 18 Fr 
catheter lubricated with silicone oil. At the end 
of the exercise, drain the fluid from the bladder 
reservoir to prevent mold. 

Install the female genitalia reducer adapter to 
prevent leaks around the catheter. 
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Appendix 
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Scenarios  
THINKING IN TERMS OF PALETTE ITEMS 

As described previously, Palette items represent complete or partial groups of settings that have 
been stored as a single item. We learned how applying partial states will hold constant all settings 
that are left unspecified. 

Not only does it take time to customize the palette, but a very large palette becomes difficult to 
navigate. So, it is desirable to minimize the number of Palette Items in each Profile. To accomplish 
this, an experienced facilitator tries to create items that are as generally applicable as possible and 
can, thus, be applied to a wide range of scenarios. The key is to only include in your Palette Items 
the settings that are directly related to the physiological event represented by that Palette Item. 

SMART SCENARIOS 

After reading the Details, Palette, and Scenarios sections of this guide, it should be clear how to 
build a scenario. You may have already tried building your own or modifying some of the factory 
presets. The following four guidelines will refine your ability to build the best possible scenarios. 

1. How will the scenario begin? 

The first thing to consider is the initial condition of the patient. Create a Palette Item to describe this 
condition. Make sure that this first step in the scenario is a complete state. That is, indicate some 
selection for each and every available setting on the Details page. Remember that only the settings 
you specify will cause a change in HAL

®
, and all other settings will remain constant. So, by starting 

with a complete state, HAL
®
's condition will always be the same when the scenario starts, 

regardless of what he was doing previously. 

Likewise, the "transition duration" of the first step in the scenario should be zero, indicating that 
changes are applied immediately. 

There is one point that can cause confusion and warrants further explanation. It is an extension of 
the above discussion of partial states. The issue is best illustrated through the following example: 

Suppose that you are creating a Palette Item to start your scenario. In this case, 
you have decided that the patient will be apneic. The question is, "How should 
the lung sounds be set?" 

Most people's first inclination is to set the lung sounds to "none." This is incorrect, 
despite apnea. Obviously, no lung sounds should be heard during apnea, but 
since you have already set respiratory rate to zero, none will be. (Sounds are 
synchronized to the breathing cycle.) 

What you are really setting here when you choose a lung sound is the condition 
of the lungs, given respiratory drive. That is, if the patient's respiratory rate were 
changed from zero, what sound would be heard? Assuming that the lungs 
themselves are normal in this scenario, you would choose "normal" for the lung 
sound setting. 

Then, as the scenario progresses, if the patient starts breathing, there will be no 
need to set the lung sound again. It will already be set. The same principle 
applies to the heart sound and other settings. 

2. Include notes to guide the facilitator during the simulation. 

It is common for scenario designers, especially those who act as facilitators, to neglect the 
importance of notes in the scenario. They think that they will remember the learning objectives, 
patient history, and other details at the time they are ready to conduct the simulation.  hey usually 
don't, especially when revisiting a scenario months after creating it. 

When you add "Wait" and "Wait Indefinitely" steps to a scenario, you have an opportunity to edit 
the item description. Use this description field to hold notes to the facilitator. Typically, scenario 
designers write notes in that space to indicate what the provider(s) or facilitator should be doing at 
that point. 
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Further, when saving the scenario, you may edit the scenario description. This is the best place to 
put patient history and any other longer notes and instructions. 

3. Assume that providers will do the right thing.  

Usually, you should create a scenario with the assumption that the providers will perform correctly. 
As long as they do, the scenario can simply be allowed to continue. 

Naturally, you must be prepared for what might happen to HAL
®
 when providers deviate from 

expectations. The consequences of such deviations can sometimes be included in the scenario, 
punctuated by "Wait Indefinitely" items. In other cases, the simulation will require more direct 
control by the facilitator via either the Palette or Details page.  

4. Choose auto-response settings based on the scenario content and the objectives. 

As you've seen, auto-responses can be used to free the facilitators attention. They also enhance 
realism by presenting instant reactions to the care providers. On the other hand, sometimes it is not 
possible or desirable to determine the responses before the simulation begins. Different 
environments and applications call for different settings. 

Some teaching practices are best done with the auto-response settings in Prompt mode. 
Responses must be triggered by a vigilant facilitator. Though it is slower and requires more 
attention, the benefit of Prompt over other modes is that the simulation can be allowed to go in any 
direction, and it will be possible to choose the response on a case-by-case basis. 

Other learning exercises require a higher degree of automation. For such applications, most 
facilitators choose Auto mode for the auto-response settings. The key issue is standardized timing 
of symptom presentation. A consistent, repeatable simulation is essential for fair assessment of 
that care provider in relation to others and for the broader interpretation of results in the context of 
training validation studies. 

When in doubt, it is best to choose Prompt mode, in which the facilitator will be given direct control 
of the responses as events are detected.
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Factory Preset Scenarios Flowcharts 

MANUAL MODE 

 

 Scenario Name Type 

1 Anthony Linear 

2 Brent Linear 

3 Christian Linear 

4 Darrell Linear 

5 Evan Linear 

6 Frank Linear 

7 Gerard Linear 

8 Bradycardia Branching 

9 Pulseless Arrest Branching 

10 Tachycardia Branching 
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HAL
®
 

Anthony

77-yr old man is found pulseless and apneic.

© 2009 Gaumard Scientific

All rights reserved 

Anthony

HR 0

BP 0/0

RR 0

O2 Sat 50%

Wait Indefinitely

Drug therapy expected

V Fib, Coarse

Wait Indefinitely

Electrical therapy 

expected

300J threshold 

V Tach, Stable

HR 120

BP 100/50

RR 16

O2 Sat 90 %

Transition Time: 10 sec

Healthy Resting

HR 75

BP 120/80

RR 13

O2 Sat 99%

Transition Time: 30 sec

End

Wait Indefinitely

Hold in stable V Tach 
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HAL
®
 

Brent

55-year old male complains of substernal chest pain radiating to the jaw .  Patient is diaphoretic, 

trembling, and has a waxing and waning mental status.

© 2009 Gaumard Scientific

All rights reserved 

Brent

HR 0

BP 0/0

RR 0

O2 Sat 85%

Wait Indefinitely

Electrical therapy 

expected

SVT

HR 160

BP 100/60

Healthy Resting

HR 75

BP 120/80

RR 13

O2 Sat 99%

Transition Time: 25 sec

End

Wait Indefinitely

Drug therapy expected

Wait

No changes are made to Hal

Transition 0:15

V Tach, Stable

HR 140

BP 120/80

RR 16

O2 Sat 90%

Transition time 0:15

Brent – BP -30%

BP -30%
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HAL
®
 

Christian

18-yr old college freshman calls EMS after taking a caffeine preparation prior to exams .  He is short 

of breath and says that his heart is "beating fast and funny."

© 2009 Gaumard Scientific

All rights reserved 

Christian

HR 160

BP 95/65

RR 20

O2 Sat 95%

Christian – BP -10%

BP -10%/-10%

Transition time 3:00

Wait Indefinitely

Drug therapy expected

End

Christian – BP +40%

BP +40%/+40%

Transition time 1:00
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HAL
®
 

Darrell

65 year-old complains of dizziness and shortness of breath.  He has a history of emphysema and 

does not know how much "breathing medicine" he has taken.  During the interview, his eyes roll 

back and he slumps in his seat, unresponsive.  (No peripheral IV sites are available.)

© 2009 Gaumard Scientific

All rights reserved 

Darrell

HR 0

BP 0/0

RR 0

O2 Sat 85%

Wait Indefinitely

Electrical therapy expected

Asystole

HR 0

BP 0/0

Healthy Resting

HR 75

BP 120/80

RR 13

O2 Sat 99%

Transition Time: 20 sec

End

Wait Indefinitely

Hold in stable V Tach

Wait Indefinitely

Drug therapy expected

V Tach, Apnea

HR 180

BP 60/30

O2 Sat 70%

V Tach, Apnea

HR 180

BP 60/30

O2 Sat 70%

Wait

V Tach is maintained breifly

Transition 0:10

V Tach, Stable

HR 140

BP 120/80

RR 16

O2 Sat 90%

Transition 1:00
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HAL
®
 

Evan

72 year-old is found tachycardic and tachypneic.  He is disoriented and barely responsive.  Patient's 

wife says that he has both heart and lung trouble and that they have been unable to afford his 

medicine in the past month.  (After "apnea" item, facilitator should set scenario auto-response to 

pacing to "none" to simulate loss of capture.)

© 2009 Gaumard Scientific

All rights reserved 

Evan

HR 140

BP 100/66

RR 30

O2 Sat 93%

Wait

No changes are made to Hal

Transition 2:00

Apnea

RR 0

Transition 0:15

Asystole

BP 0/0

RR 0

O2 Sat 70%

End

BP -30%

BP -30%/-30%

Wait

PEA treatment expected

Transition 3:00

Cardiopulmo Decline

HR -70%

BP -40%/-40%

RR -70%

O2 Sat 85%

Transition 0:40

Wait Indefinitely

Pacing expected
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HAL
®
 

Frank

50 year-old found at home complains of weakness and fatigue.  He is conscious and alert but slightly 

short of breath.  An empty bottle of digoxin sits on his bedside table .  (He will claim not to have taken 

any in several days.  Pharmacological rate control will only be effective briefly .)

© 2009 Gaumard Scientific

All rights reserved 

Frank

HR 180

BP 90/50

RR 22

O2 Sat 93%

Wait Indefinitely

Drug therapy expected

End

HR Spike

HR +50%

BP -30%/-30%

Transition 0:30

Wait Indefinitely

Cardioversion Expected

HR Drop

HR -40%

BP +20%/+20%

Transition 0:20

Wait

Patient remains stable

Transition 2:00
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HAL
®
 

Gerard

35 year-old man calls for help at local restaurant after onset of alarming respiratory symptoms .  

(Patient experiencing allergic reaction to food, asthma attack, or exposure to inhaled toxin.)

© 2009 Gaumard Scientific

All rights reserved 

Gerard

HR 85

BP 130/90

RR 20

O2 Sat 98%

Respiratory Allergy

Stridor, biphasic

RR 30

Tongue Edema

Wheezing

O2 Sat 91%

Transition 4:00

End

Healthy Resting

HR 75

BP 120/80

RR 13

O2 Sat 99%

Transition 2:00

Closed Airway

Tounge Edema

Laryngospasm

Pharyngeal swelling

Wait Indefinitely

Drug therapy expected
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HAL
®
 

Bradycardia

An in-hospital patient is diagnosed with Bradycardia and requires immediate attention.  

Note: for this scenario to function as intended the instructor should enable automatic pacing 

capture in the 'Setup -> Auto-Responses' menu.  

© 2009 Gaumard Scientific

All rights reserved 

Bradycardia

HR 50

BP 90/60

RR 10

O2 Sat 96%

Wait

No changes made 

Transition 2 min

End

Complaint – “Feel 

dizzy”

Cardio Drop

HR -15%

BP -10%/-10%

O2 Sat -5%

Confusion – “What 

happened?”

Wait Indefinitely PaceAtropine Administered

Dopamine 

Administered

Epinephrine 

Administered

Atropine

HR +10%

BP +7%

1:00

Pace
Atropine Administered

Epi Infusion

HR +5%

BP +8%

1:00

Dopamine

HR +5%

BP +5%

1:00

Pace Response

BP 100/70

O2 Sat 97%

1:00

Urgency – 

“OUCH!!!,” “That 

Hurts,” 

“OUCH!!!”

Epinephrine Administered
Dopamine

Administered
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  © 2008 Gaumard Scientific

All rights reserved 

Pulseless Vtach 1

HR 168

BP 50/30

RR 0

OSat 85%

Unconscious

Cyanotic

Wait Indefinitely

Vtach rhytm

HR 168

Asystole rhythm

BP 0/0

SVT rhythm with Brief 

Sinus Pause

SVT

HR 180

BP 80/55

RR 9

OSat +5%

Osat Increase 1

O2Sat 2%

Healthy Resting with

Brief Sinus Pause

HR 75

BP 120/80

RR 13

O2 Sat 99%

SVT rhythm pulseless

SVT

HR 180

BP 50/35

Healthy Resting

NSR

HR 75

BP 120/80

RR 13

OSat 99%

SVT rhythm

HR 180

BP 80/55

RR 9

OSat +5%

VF rhythm

BP 0/0

Inspiration 0%

OSat -5%

HAL
®
 

Pulseles Arrest

A young male was found unconscious.

Add 

Oxygen

Progress To Vfib

Progress to PEA (SVT)

Progress to 

SVT  with Pulse

Progress

To

Healthy

Patient

Progress

To

VTach

Progress 

To

 Asystole

Adenosine Therapeutic Response

Adenosine 

Non-Therapeutic 

Response
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AUTOMATIC MODE 

 Scenario Name Patient Name Type 

1 Pulseless and Apneic Anthony Linear 

2 Chest Pain Brent Linear 

3 Overdose Caffeine Christian Linear 

4 Apnea Darrell Linear 

5 Cardiac Resp. Failure Evan Linear 

6 Drug Overdose Frank Linear 

7 Respiratory Allergy Gerard Linear 

8 Unexpected OSat Drop Nicolas Linear 

9 Cardiac Arrest Brent Branching 

10 Sudden Collapse Darrell Branching 

11 Pulmonary Edema Ira Branching 

12 Trauma Jim Branching 

13 Bradycardia Kevin Branching 

14 Diving Accident Lloyd Branching 

15 Tamponade Matthew Branching 

16 Airway Obstruction Nicolas Branching 



HAL | User Guide | 151 

HAL
®
 

Pulseless and Apneic – Anthony

Automatic Mode

77-yr old man is found pulseless and apneic.

© 2009 Gaumard Scientific

All rights reserved 

Start State

HR 0

BP Auto

RR 0

O2 Sat: Auto

Wait Indefinitely

Drug therapy expected

V Fib, Coarse

HR 0

BP 0/0

RR 0

O2 Sat Auto

Wait Indefinitely

Electrical therapy 

expected

300J threshold 

V Tach, Stable

HR 120

BP Auto

RR 16

O2 Sat 90 %

Transition Time: 10 sec

Healthy Resting

HR 75

BP Auto

RR 13

O2 Sat 99%

Transition Time: 30 sec

End

Wait Indefinitely

Hold in stable V Tach 
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HAL® 

Chest Pain – Brent
Automatic Mode

55-year old male complains of substernal chest pain radiating to the jaw .  Patient is diaphoretic, 

trembling, and has a waxing and waning mental status.

© 2009 Gaumard Scientific

All rights reserved 

Start State

HR 140

BP Auto

RR 20

O2 Sat Auto

Wait Indefinitely

Electrical therapy expected

SVT

HR 160

BP Auto

Healthy Resting

HR 80

BP Auto

RR Auto

O2 Sat Auto

End

Wait Indefinitely

Drug therapy expected

Wait

No changes are made 

Transition 0:15

V Tach, Stable

HR 140

BP Auto

RR 16

O2 Sat 90%

BP Drop

BP Auto

RR Auto

O2 Sat Auto

Wait

No changes are made

Transition 0:30 
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HAL
®
 

Overdose Caffeine - Christian

Automatic Mode

Christian is short of breath and says that his heart is "beating fast and funny."

© 2009 Gaumard Scientific

All rights reserved 

Christian

HR 160

BP Auto

RR 20

O2 Sat 95%

Wait Indefinitely

Scenario is ready to run

End

Decreased BP

BP Auto

Contractility RA/LA 60%

Contractility RV/LV 50%

Wait

Wait while model reaches 

initial state

Wait Indefinitely

Drug therapy expected

Speech – Heat 

beating fast
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HAL
®
 

Cardiac Resp Failure – Evan

Automatic Mode

The patient is found tachycardic and tachypneic.  He is disoriented and barely responsive.  (After 

"apnea" item, facilitator should set scenario auto-response to pacing to "none" to simulate loss of 

capture.)

© 2009 Gaumard Scientific

All rights reserved 

Start State

HR 140

BP Auto

RR 30

O2 Sat 93%

Contractility 80%

Wait

No changes are made to Hal

Transition 2:00

Apnea

BP Auto

RR 0

O2 Sat Auto

Contractility 50%

Asystole

HR 0

BP Auto

RR Auto

O2 Sat Auto

End

Decreased BP

BP Auto

RR Auto

O2 Sat Auto

Contractility 30%

Wait

No changes are made

Transition 3:00

Cardiopulmo Decline

HR -70%

BP Auto

RR -70%

O2 Sat Auto

Wait Indefinitely

Hold  until action is taken
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HAL
®
 

Drug Overdose – Frank

Automatic Mode

Frank was found at home  and complains of weakness and fatigue .  He is conscious and alert but 

slightly short of breath.  An empty bottle of digoxin sits on his bedside table .  (He will claim not to 

have taken any in several days.  Pharmacological rate control will only be effective briefly ).

© 2009 Gaumard Scientific

All rights reserved 

Overdose Digoxin

HR 180

BP Auto

RR 22

O2 Sat 93%

Wait Indefinitely

Scenario is ready to run

End

HR Spike

HR +200%

BP Auto

RR Auto

O2 Sat Auto

Contractility RV/LV 50%

HR Drop

HR -40%

BP Auto

RR Auto

O2 Sat Auto

Contractility RV/LV 65%

Wait

No changes are made
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HAL
®
 

Respiratory Allergy – Gerard

Automatic Mode

Patient calls for help at local restaurant after onset of alarming respiratory symptoms .  (Patient 

experiencing allergic reaction to food, asthma attack, or exposure to inhaled toxin.)

© 2009 Gaumard Scientific

All rights reserved 

Slightly Allergic

HR 85

BP 130/90

RR 20

O2 Sat Auto

Inspiratory Stridor

Severe Allergy

BB Auto

RR 30

O2 Sat 91%

Biphasic Stridor

Tongue Edema

End

Healthy Resting

HR 75

BP Auto

RR 13

O2 Sat Auto

Throat Sounds Normal

Closed Airway

BB Auto

RR 30

O2 Sat 91%

Biphasic Stridor

Tongue Edema

Laryngospasm

Pharyngeal swelling

Wait Indefinitely

Hold until action is taken
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HAL
®
 

Unexpected Osat Drop – Nicolas
Automatic Mode

Patient is intubated and connected to breathing circuit . But the vitals start to drop because of the 

blocked airway. When the problem is recognized and the correct action is taken , the patient goes to 

a stable state.

© 2009 Gaumard Scientific

All rights reserved 

Start State

HR 90

BP 114/78

RR Auto

O2 Sat 95%

Asthma

Code

HR 151

BP 80/42

RR Auto

O2 Sat 62%

Ventricular tachycardia

Conclusion

HR 90

BP 114/78

RR Auto

O2 Sat 100%

End

Wait Indefinitely

Wait until action is taken

Resolution

HR 87

BP 108/72 

RR Auto

O2 Sat 96%

Sinus

Inability2ventilate

HR 95

BP 110/75

RR Auto

O2 Sat 92%

Wait

Wait until initial state is reached

Transition 0:30 
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© 2008 Gaumard Scientific

All rights reserved 

Start State

HR 140

BP Auto

RR 20

O2 Sat Auto

Acute Inferior MI

Start O2

Administer drug

Wait Indefinitely

Deterioration

BP Auto

RR Auto

Cardiac Irritability

(slight deteriorate)

Healthy Resting

HR 80

BP Auto

RR 16

O2 Sat Auto

V-Tach

HR 180

BP Auto

Contractility RA/LA 50%

Contractility RV/LV 20%

Unresponsive

V-Tach

HR 140

BP Auto

RR 16

O2 Sat 90%

Contractility RV/LV 80%

Responsive

Cardiac Deterioration

10 seconds time out 10 seconds time out

Yes

No

Healthy State

Stable V-TachUnstable V-Tach

Times out in 10 seconds Times out in 10 seconds

HAL
®
 

Cardiac Arrest – Brent

Automatic Mode

Brent complains of substernal chest pain radiating to the jaw . Patient is diaphoretic, trembling, and 

has a waxing and waning mental status.

END
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Start State

HR 80

BP Auto

RR Auto

O2 Sat Auto

Emphysema

V Tach, stable

HR 140

BP Auto

RR 16

O2 Sat Auto

V Tach Apnea

HR 180

BP Auto

RR 0

Contractility 50%

HAL
®
 

Sudden Collapse – Darrell

Automatic Mode

Darrell complains of dizziness and shortness of breath.  During the interview, his eyes roll back and 

he slumps in his seat, unresponsive.  (No peripheral IV sites are available.)

Wait Indefinitely

END

VFib

HR 0

BP Auto

Airway opened

Ventilation

Healthy Resting

HR 75

BP Auto

RR 13

O2 Sat 99%

YES

Wait Indefinitely NO
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Pulmonary Edema

HR: 45

BP: Auto

RR: 10

O2 Sat: Auto

© 2008 Gaumard Scientific

All rights reserved 

Start O2

Place monitor and 

leads

Start IV

Heart Rate Deterioration

HR 160%

BP Auto

RR Auto

O2 Sat Auto

YES

Pulseless Vtach

BP Auto

RR Auto

O2 Sat Auto

Contractility 20%

NO

Wait Indefinitely

Pulse Returns

HR: 85

BP: Auto

RR 15

OSat: 95%

NSR

Contractility 100%

Asystole

HR 0

BP Auto

RR Auto

O2 Sat Auto

CPR

Electrical Therapy

Drug Therapy

CPR

Drug Therapy

 Unsuccessful

END

Times out in 10 seconds

Unsuccessful

Successful

Successful

Hal
®
 

Pulmonary Edema 

Automatic Mode

The patient is found complaining of chest discomfort and shortness of breath .  She is weak, 

lightheaded, and diaphoretic.

To Pulseless Vtach

(After transcutaneous pacing)

Times out in 10 seconds

To Asystole

(No Transcutaneous Pacing)

END
Times out

In 10 seconds
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Bleeding

HR 70

RR 15

BP Auto

RR Auto

O2 Sat Auto

Bleeding (Left Leg)

Stop Bleeding

BP Auto

RR Auto

O2 Sat Auto

Bleeding stopped

Asystole

HR 0

BP Auto

Cyanosis

Radial pulse Absent

Brachial pulse Absent

HAL
®
 

Trauma – Jim

Automatic Mode

The victim was found in a building collapse accident. His left leg is amputated and Bleeding.

Wait IndefinitelyStopped Bleeding To Asystole

END
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Bradycardia

HR 45

BP Auto

RR 10

O2 Sat Auto

Contractility 70%

Wait Indefinitely

Cardio Drop

HR -15%

BP Auto

RR Auto

Contractility 60%

HAL
®
 

Bradycardia – Kevin

Automatic Mode

Note: for this scenario to function as intended the instructor should enable automatic pacing capture 

in the 'Setup -> Auto-Responses' menu.  A in-hospital patient is diagnosed with Bradycardia and 

requires immediate attention.

END

Speech – Feel 

dizzy

Wait 

Wait for student action

Transition 2 min

Speech – What 

happened

Wait 

Pacing expected

Transition 2 min

Pace

Asystole

HR 0

BP Auto

RR Auto

NO

Pace Response

BP Auto

RR Auto

O2 Sat Auto

Contractility 80%

YES

Speech – Ouch, 

that hurts, Ouch
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Patient Rescued

HR 180

BP Auto

RR 10

O2 Sat Auto

Pneumothorax

Emphysema

Wait Indefinitely

HAL
®
 

Diving Accident – Lloyd

Automatic Mode

Patient was just rescued from a diving accident. He is unconscious and unresponsive while the boat 

crew clears his equipment. He has a pulmonary edema that won't heal until he is placed in a 

hyperbaric chamber.

END

Wait 

Wait for model to reach vitals

Transition 1 min

Patient airlifted to 

chamber

Hyperbaric

BP Auto

RR Auto

O2 Sat Auto

Ambient Pressure 3 ATM

Normal Pressure

BP Auto

RR Auto

O2 Sat Auto

Ambient Pressure 1 ATM

NO

YES
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Unstable SVT with pulse

HR: 160

BP: Auto

RR Auto

O2 Sat Auto

Distant Heart Sound

Contractility 50%

© 2008 Gaumard Scientific

All rights reserved 

Start O2

Place monitor 

and leads

Start IV

Slight Deteriorate

Cardiac Irritability: Slight (deteriorate)

Wait Indefinitely 

Hold until action is taken

YES
NSR

HR 85

BP 118/78

Normal Heart 

Sound

Coarse Vfib

HR 0

BP Auto

Ventricular Fibrillation

Asystole

HR 0

BP Auto

HAL
®
 

Tamponade – Matthew

Automatic Mode

A young male was found injured in a high speed collision after drag -racing on the expressway. He 

lost control of vehicle and crashed into a highway divider . BAC: 0.10.

CPR

Analyze Rhythm

Shock (choose not 

to convert)

YES

NO

NO

PEA

HR 100

BP Auto

RR 0

O2 Sat Auto

No radial or brachial pulse

END

Times out in 10 seconds

Perdiocardiocentesis

To Asystole

Synchronized Cardioversion

 (choose not to convert)

To VFib

To PEA
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Patient Rescued

HR 120

BP Auto

RR 15

O2 Sat Auto

Asthma

Stridor, biphasic

Wait Indefinitely

HAL
®
 

Airway Obstruction – Nicolas

Automatic Mode

Patient is intubated and connected to breathing circuit . But the vitals start to drop because of the 

blocked airway. When the problem is recognized and the correct action is taken, the patient goes to 

a stable state.

END

Patient airlifted to 

chamber

Airway Cleared

HR 90

BP Auto

RR Auto

O2 Sat Auto

Irritability great (improve)

NOYES

Cardiac Irritability

HR 120

BP Auto

RR 15

O2 Sat Auto

Asthma

Irritability slight (deteriorate)
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Troubleshooting 

Symptom Possible Cause Solution 

Communication never 
gets established or is 
lost 

(blinking 

communication 
indicator is consistently 
red) 

Battery is discharged or 
damaged 

Plug the charger and if communication is established 
then charge battery as per procedure explained in the 
manual. 

Computer is too far away 
from simulator 

Get simulator closer to computer 

Trying to communicate with 
a different simulator 

Make sure to select the right simulator when opening 
the software.  

In a multiple simulator environment (“Setup/Options” 
menu), make sure to enter the right Serial Number 

Starting more than one 
simulator simultaneously  

Select different channels for each of the simulators, and 
then try to turn them on one at a time, which means to 
wait until a link have been established between the 
tablet and the first simulator. Only after that, start the 
User Interface software in the second tablet, and so on 
for the rest of the simulators. To do so go to menu 
Setup -> Options-> Environment -> Select ‘Auto change 
to channel: X’ (X = number from 1 – 11). 

All others Close the User Interface software and unplug the RF 
module for at least 5 seconds, then plug it back in. 
Restart the software and wait for initialization 

Simulator doesn’t run 
for the time specified 
on the manual  

Battery not charge properly Make sure that LED indicator on battery charger goes 
thru the sequence described in its label, usually red or 
orange after plugging it, and then green when charge is 
completed.  

If LED does not go thru label’s indications, then: 

 Check plug connection making sure it is all the way 
in. 

 Make sure you are using the appropriate charger, 
which is labeled with its simulator name. 

 

Simulator doesn’t 
respond to any 
command even that 
blinking 
communication 
indicator is 
consistently green 

The computer is properly 
communicating with a 
simulator, but not 
necessarily the one you 
intend to control 

If you have more than one simulator in your facility, 
make sure that your computer is properly set-up to 
control the simulator that you wish to control. Go to 
Options... on the Setup pull-down menu and check the 
Environment preferences 

Commands are taking 
longer than usual to 
take effect or 
simulator is not 

Distance between computer 
and simulator is reaching its 
limit, or there are too many 
obstructions in between 

Get simulator closer to computer or move away from 
obstructions. 
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Symptom Possible Cause Solution 

reporting every action 
(Signal strength 
indicator is low) 

(walls, etc.) 

There’s too much RF 
interference either from 
another Gaumard tetherless 
simulator in the vicinity or 
an RF radiator 

Try changing the RF channel by going to (menu) Setup -
> Options-> Environment -> Select ‘Auto change to 
channel: X’ (X = number from 1 – 11). 

 

Sound quality while 
streaming audio is 
poor 

Noisy channel or another 
Gaumard tetherless 
simulator is nearby 

Select a different channel (see “Options and more” 
section). When more than one simulator is in the 
vicinity, allow one channel between simulators. 

Computer too far from 
simulator 

Streaming audio can’t reach as far as normal data with a 
range of up to 150 ft. / 50 meters line of sight between 
simulator and PC. Keep antenna upright for maximum 
range. 

Sound too low or too loud Sound volume at PC side is managed from PC”s volume 
control. Simulator sound volume is managed thru 
“Output Gain” slider under the “Speech/Streaming 
Options” tab. 

Always talk as close as possible as microphone in order 
to improve quality. Using a headset is recommended. 

Respiration and other 
undesirable sounds are 
heard by instructor 

Since simulator’s microphone sensitivity is high in 
order to capture the voice of providers, it also captures 
all surrounded noises on or around the simulator. This 
is normal and it is not a malfunction. 

Disable the tablet’s onboard microphone and enable the 
headset input using the Windows audio setting. 

Streaming audio does 
not work; streaming 
voice controls are not 
shown. 

“Single” simulator is 
checked under 
“Setup/Options” menu. 

Make sure to select multiple simulator environment 
(“Setup/Options” menu), and enter the Serial Number of 
the simulator you are trying to communicate. Streaming 
audio does not work when “Single” simulator is 
checked. 

GIGA has set the 
power mode to 
STAND-BY 
automatically 

The battery on the simulator 
is depleted 

In Hal Revision 14 and lower, replace battery for a 
charged one. For S3004, S3009, and S3010, plug the 
external power supply. For all others including Hal 
Revision 15 and above plug in the charger. 

"RF module not 
found" message is 
displayed when GIGA 
is started 

RF module not connected  Connect the RF module to any USB port. 

RF module not identified by 
the computer. 

Close the software and disconnect the RF module for 10 
seconds, then plug it back in and restart the software 

Chest compressions 
are not properly 
detected or not 
detected at all 

Is the communication signal 
strength indicator 
consistently low? 

See “Scan RF Channels” section 

Is the respiratory rate set to Set respiration rate to zero 
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Symptom Possible Cause Solution 

'0 / min'? Chest 
compressions are only 
detected when the 
respiratory rate is set to 0 
per minute (0 / min). 
Otherwise they are ignored 

All others See “Calibration” section 

Artificial ventilations 
are not properly 
detected or not 
detected at all 

Is the communication signal 
strength indicator 
consistently low? 

See “Scan RF Channels” section 

All others See “Calibration” section 

NIBP values are not 
accurate 

NIBP is disabled or not 
installed 

Go to Setup>Options>HAL Add-Ons and check mark 
“USE NIBP”. Continue to the NIBP hardware section to 

calibrate the NIBP feature. 

Korotkoff sounds do 
not match systolic 
and/or diastolic set 
values 

BP sensors are offset Recalibrate BP cuff sensors on the simulator as per 
“Calibration” section 

NIBP feature is enabled Go to Setup>Options>HAL Add-Ons and un check “USE 
NIBP”. Continue to the hardware section to calibrate the 

manual blood pressure. 

Wrong placement of BP Cuff 
(only for simulators with 
tetherless BP cuff feature) 

See correct cuff placement under section “Circulation” 

Simulator’s chest 
does not rise with 
artificial ventilation 
(e.g. BVM) 

Simulator is not running In some simulators, the trachea is disconnected from 
the lungs when they are not on 

Disable lung/s Enable the lungs from “Detail” page on the User 
Interface software 

Surgical insert is installed The ventilation trachea insert provides a better seal for 
ventilation. 

Low chest rise (or no 
chest rise at all) while 
breathing  

Wrong settings or disable 
lungs 

Make sure lungs are enabled and both respiration rate 
and inspiration percent are different than ‘0’. Try 
changing the respiration rate to a different value or turn 
the simulator off and then on again. 

Loss of brachial pulse Brachial pulses disable  Make sure to enable brachial pulse on “Details” tab 
page. 

 Wrong reading of 
corresponding BP sensor 

Brachial pulse is cut off when BP cuff pressure is above 
Systolic. If it is not connected, then recalibrate BP cuff 
sensors on the simulator as per “Calibration” section. 
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Symptom Possible Cause Solution 

Reporting intubation 
when it is not 

Wrong sensor reading Reset “ET Tube” sensor on simulator as per 
“Calibration” section. Do not turn on (or power cycle) 
the simulator while being intubated, doing so would 
cause the sensor to report wrong intubations. 

Pre-built scenarios 
don’t show up 

 Select “Quick Start Scenarios” when starting the 
software. Should user forget to do so, there’s no need 
to shut down the software and open it again in order to 
load the pre-built scenarios. Go to “File/Profile” menu 
and then select “Modeled Scenarios” 

A sound is not heard 
or heard not at 
desired volume level 

Cyanosis intensity is 
too much or too little 

Volume not set to user’s 
criteria 

Every sound has a volume control. Play with volume 
control to get it to desired level 

Cyanosis intensity is 
too much or too little 

Cyanosis intensity not set 
to user’s criteria 

Set Cyanosis level to a desired level by playing with the 
“Set Max cyanosis level” control 

Pupils (either one or 
both) dilating either 
while blinking or 
when not supposed 
to 

Wrong dilation calibration Set pupil dilation level properly by following procedure 
described in the manual under section “Options and 
more…” (see Tolerances Tab) 

Pupils constricting-
dilating constantly 

This might happens either 
when the simulator is under 
intense light or wrongfully 
calibration 

Try the “Set to Ambient Light” feature under 
“Options/Tolerances” (see section “Tolerances “). 

Oximeter reading 
does not coincide 
with value set 

Using a different 
Oximeter/Sensor for which 
the simulator was calibrated 

 The simulator must be calibrated with the Oximeter 
instrument that it is going to be used (including the 
Pulse Oximeter Sensor). Oximeter Sensors cannot 
be swapped even with same kind of oximeter’s 
brand and model. 

 An oximeter which includes carbon monoxide 
and/or methemoglobin sensing cannot be used. 

 Oximeter has been placed on the arm that doesn’t 
have the O2Sat feature. Check in the Diagnostic if 
that arm has the feature installed 

 

Pulse Oximeter Sensor not 
properly placed 

Make sure to slide the Pulse Oximeter Probe all the way 
into the simulator’s finger. Make sure the emitter part 
(the red light) of the probe is on the nail side of the 
finger. If user is sure that the probe is properly placed, it 
means that it was not when calibration was performed, 
then re-calibration is necessary. See O2Sat calibration 
section for more info. 
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Symptom Possible Cause Solution 

Offset value within +/- 2 User should expect a +/- 2 discrepancy between value 
set and Oximeter reading for O2Sat values above 80%, 
and +/-3 below 80%. 

Drug ID is not being 
read 

 

Syringe has not been 
programmed 

See “IV Medication Infusion” section 

Syringe is not in the field of 
the RFID reader 

This could happen when injecting the cephalic vein 
close to the hand and having the syringe sideways to 
the plane of the forearm. 

Wrong calibration Calibrate the drug arm as per calibration 
instructions 

Injecting too fast Maximum injection rate is 9999 ml/hr. This rate won’t be 
exceeded when injecting into the veins using a 22 g 
needle.  

Not reading the syringe ID If RFID tag on syringe is not read, the system tends to 
read fewer amounts than actually injected. This could 
happen when infusing the drug thru the side port on the 
arm. When doing so, place a tagged syringe on the 
syringe holder. See “IV Medication Infusion” section 

Fluid reservoir is full The maximum amount of fluid injected properly read 
before purging the internal reservoir is 50 cc. Make sure 
to purge the reservoir or permanently connect a purging 
line (see instructions) 

CO2 not being 
exhaled 

 

Empty CO2  cartridge Make sure the CO2  cartridge is in place. For S3201, the 
User Interface displays the “Low CO2” message when 
CO2 pressure is low.  

 

Notice that CO2  cartridge must be plug just before the 
training section starts to get maximum duration. If left 
overnight, the  cartridge will slowly empty. (See “CO2 
exhalation” section). The CO2  cartridge once it is 
plugged, will empty within 24 hours whether it is used 
or not.  

CO2 pressure regulator is 
“OFF” 

For S3201, go to “Calibration/Factory Settings” and then 
press the “CO2 Pressure” button. In the window to the 
right a value between 3-6 psi (ideal 4.5 psi) indicates 
good level. Should not be the case, call tech support for 
advanced troubleshooting. 

Mechanical Ventilator 
is not triggered when 
assisting the 
simulator 

Settings exceeding the 
simulator’s capabilities 

The simulator is able to trigger the ventilator either 
when: 

 

- Flow ≤ 1 Lts/min, or Pressure ≤ 1 cmH2O 
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REFERENCE LUNG COMPLIANCE VALUES 

The graph below shows the relation between HAL’s nine lung compliance levels and the resulting peak inspiratory 
pressure readings on the ventilator. At compliance level 9, the lung is most compliant so the PIP is relatively low, 
while at compliance level 0 the lungs are least compliant resulting in higher PIP. For this example, the ventilator was 
set with the following parameters: 

 Ventilation type: Volume controlled 

 Tidal volume of 550 mL 

 Flow of 40 l/min 

 Patient weight is 75 Kg (165 lbs.) 

To accommodate for fluctuations in the results as seen on ventilators, values on the graph may differ by +/- 2. 

 

 

0

10

20

30

40

50

60

C9 C8 C7 C6 C5 C4 C3 C2 C1 C0

Static Lung Compliance vs Peak Inspiratory Pressure 



174 | HAL | User Guide 

Wireless Network 
GIGA generates the vital signs information 
displayed on the virtual monitor PC. The 
information is transmitted through a wireless 
ad-hoc connection between the two 
computers in real time. 

The wireless settings are configured at the 
factory, so no additional configuration is 
required. Please reference the 
troubleshooting information on page 102 to 
resolve common connectivity issue before 
attempting to reconfigure the network. 

Use the “Create an ad-hoc Wireless 
network” tool to configure the wireless ad-
hoc link between the two computers. Then, 
configure the connection between GIGA and 
the Gaumard Monitors software. 

GIGA NETWORK 
CONFIGURATION 

Complete the next steps using the 
“Controller - Create Ad-Hoc Wireless 
Network” tool built in to GIGA software.  

1. From the menu bar, go to Help > 
“Create ad-hoc Wireless Network” 

The “Controller - Create Ad-hoc 
Wireless Network” window is displayed 

2. Select the “Wireless Network Adapter”. 
If the wireless adapter is not listed, first 
enable the adapter using the Windows

®
 

network menu and then return to this 
window. 

 

3. Enter a wireless network name (case 
sensitive). Use the same wireless 
network name to configure the Gaumard 
Monitors PC. “GaumardNet” is the 
required name for Windows

®
 7 

computers. 

 

4. Set the “Controller IP”.  

On each control PC and virtual monitor 
PC, enter the same values for the first 
three IP fields and a set unique value for 
the last field. The suggested address is 
for the Controller IP is 10.1.1.200 

 

5. Click “Apply Wireless Network Settings” 
to save the settings. 

6. Restart the computer. 

 

GAUMARD MONITORS NETWORK 
CONFIGURATION 

After the GIGA control computer is 
configured, complete the next steps using 
the “Create an ad-hoc network tool” included 
in Gaumard Monitors software.  

1. On the virtual monitor computer, click 
the Gaumard Monitors icon to start the 
vital signs software. 
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2. Click the V menu near the top left corner 
and select “Create Ad-Hoc Network”. 

 

The “Virtual Monitor - Create ad-hoc 
Wireless Network” window is displayed. 

3. Select “Wireless Network Adapter”. If 
the wireless adapter is not listed, first 
enable the adapter using the Windows

®
 

network menu and then return to this 
window. 

 

4. Enter a wireless network name (case 
sensitive). Use the same name entered 
in the controller computer. 
“GaumardNet” is the required name for 
Windows

®
 7 computers.  

 

5. Set the “Monitor IP”.  

On each control PC and virtual monitor 
PC, enter the same values for the first 
three IP fields and a set unique value for 
the last field. The suggested address is 
for the Monitor IP is 10.1.1.220 

 

6. Click “Apply Wireless Network Settings” 
to save the settings. 

7. Restart the computer. 
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CONFIGURE THE VITAL SIGNS 
BROADCAST 

After the wireless ad-hoc link is established 
between both computers, complete next 
steps to configure the transmission of the 
vital signs information.  

1. Verify that both computers are 
connected to the GaumardNet network 
using Windows

®
 wireless connection 

menu. If the computers are not 
connected, select the “GaumardNet” 
network and click “Connect” manually. 

 

2. Start the GIGA control software. 

3. On the GIGA menu bar, click Monitors> 
Configuration. 

The “HAL Virtual Monitor Setup” window 
is displayed. 

4. Set the adapter to “Wireless network 
connection” and click “Connect” to begin 
transmitting the vital signs information. 
Write down the “controller IP” and “Port 
number”.  

5. Start the Gaumard Monitors software on 
the virtual monitor PC. 

6. Click the “V” menu near the top left 
corner, and then select “Comm Setup”. 

The “TCP Comm Setup” window is 
displayed. 

7. Enter the “Controller IP” and “Port 
number” displayed on the GIGA “Virtual 
Monitor Setup” window.  

Click “Connect” to accept the incoming 
connection. 
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Selected parts list S3201 
 

Item ID Name Type Description 

S3201.001 A/C Virtual Monitor R 
A/C Powered 17" Touch Screen monitor and desktop, VM 
software included 

S3201.002 D/C Virtual Monitor R 
D/C Powered 12" Touch Screen Mobile Monitor with 
stylus, VM software included 

S3201.003 D/C Virtual Monitor Upgrade A 
D/C Powered 12" Touch Screen Mobile Monitor with stylus 
upgrade 

S3201.004.L Traumatic Leg Amputation A 
Trauma Amputation Leg for HAL, light color (also 
available medium or dark) 

S3201.005.L Traumatic Arm Amputation A 
Trauma Amputation Arm for HAL, light color (also 
available medium or dark) 

S3201.006 Casualty Simulation Kit A Bleeding and non-bleeding wounds 

S3201.009 Power Package R 100-240 V AC battery charger with rechargeable battery 

S3201.018.L Chest skin  R 
12 lead chest skin, light color (also available medium or 
dark) 

S3201.024L.R2.L 
Lower Left Osat Arm 
Revision 2 

M 
Lower left Osat arm with Osat index finger and 
microphone, light color (also available medium or dark) 

S3201.027L.D Lower left leg R 
Lower left leg assembly, dark color (also available medium 
or light) 

S3201.028R.L Right I/O leg  R 
Lower Right I/O leg assembly, light color (also available 
medium or dark) 

S3201.029R.L I/O Leg Skin Cover C  Light color (also available medium or dark) 

S3201.030 Reservoir bone R Reservoir bone used in I/O leg access 

S3201.031 I/O Bones  C Replacement bone for I/O leg 

S3201.032.D Surgical Trachea   Surgical trachea insert, dark color 

S3201.032.L Surgical Trachea   Surgical trachea insert, light color 

S3201.032.M Surgical Trachea   Surgical trachea insert, medium color 

S3201.054L.M Real BP Upper Left Arm  M 
Medium color upper left arm assembly with real BP for use 
with normal cuff, medium color (also available light or 
dark) 

S3201.060 Simulator Transport Case R Soft storage and transport case with wheels 
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Item ID Name Type Description 

S3201.078 CO2 Exhalation  A 
CO2 Exhalation feature ordered at the time of initial 
purchase 

S3201.080 
Simulated Blood 
Concentrate 

C   

S3201.081 Silicone Oil C Oil-based silicone lubricant 

S3201.087 
Wireless Streaming Audio 
Headset 

R   

S3201.104 ECG/Pacer Module R   

S3201.211 ETC Pro+ A 
Recording and debriefing solution. Includes two wireless 
and hard-wired camera for multiple video and audio 
stream. 

S3201.211.U ETC Pro+ Upgrade U 
Recording and debriefing solution upgrade. Includes two 
wireless and hard-wired camera for multiple video and 
audio stream. 

S3201.224L.R2.L 
Lower Left Osat Arm Rev 2 
Reveining 

M 
Lower left Osat arm with Osat index finger and 
microphone reveining, light color (also available medium 
or dark) 

S3201.410 Drug Recognition Syringes R Set of 10 drug recognition syringes with tags 

S3201.411 
Replacement Antecubital 
Veins 

R Set of 10 veins 21" long and 10 veins 7" long 

S3201.412 Drug Recognition Filling Kit R 60cc syringe with fill and drain tubes 

S3201.413 
Syringe Programming 
Holder 

R   

S3201.INST In-Service Training A Day of in-service training and installation 
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Selected parts list S3101/S3000 
 

Item ID Name Type Description 

S3101.001 A/C Virtual Monitor A A/C Powered 17" Touch Screen monitor 

S3101.002 D/C Virtual Monitor A D/C Powered 12" Touch Screen Mobile 
Monitor with stylus 

S3101.004.L Traumatic Leg Amputation A Trauma Amputation Leg for HAL®, lite color 

S3101.005.L Traumatic Arm Amputation A Trauma Amputation Arm for HAL®, lite 
color 

S3101.006 Casualty Simulation Kit A Bleeding and non-bleeding wounds 

S3101.009 Power Package R 100-240 V AC battery charger with 
rechargeable battery 

S3101.016.L Neck Collars C Lite color neck collars, set of 6 

S3101.018.L Chest skin  R  Lite color 

S3101.023L.L Lower Left Arm C Lower left IV arm, lite color 

S3101.023R.L Lower Right Arm C Lower right IV arm, lite color 

S3101.024L.L Lower Left Osat Arm C Lower left IV arm with Osat index finger, lite 
color 

S3101.024R.L Lower Right Osat Arm C Lower right IV arm with Osat index finger, 
lite color 

S3101.025.L Abdominal skin R Lite color 

S3101.027L.D Lower left leg R Lower left leg assembly, lite color 

S3101.027L.L Lower left leg R Lower left leg assembly, lite color 

S3101.028R.L Right I/O leg  R Lower Right I/O leg assembly, lite color 

S3101.029R.L I/O Leg Skin Cover C Lite color 

S3101.030 Reservoir bone R Reservoir bone used in I/O leg access 

S3101.031 I/O Bones  C Replacement bone for I/O leg, set of 7 

S3101.043.L Intramuscular Thigh Injection 
Sites 

R Lite color, set of 2 (one per leg) 

S3101.048 Adult IV Filling Kit R Fluid dispensing syringe with filling tube 

S3101.049 Adult I/O Filling Kit R   

S3101.060 Simulator Transport Case R Soft storage and transport case with 
wheels 

S3101.061 Simulator Transport Case A Hard storage and transport case with 
wheels 

S3101.080 Simulated Blood Concentrate C   

S3101.081 Silicone Oil C Oil-based silicone lubricant 
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Item ID Name Type Description 

S3101.200 Audio & Video Recording System A   

S3101.400R.L Automatic Drug Recognition 
System 

A Automatic Drug Recognition light color 
right arm 

S3101.400R.M Automatic Drug Recognition 
System 

A Automatic Drug Recognition dark color 
right arm  

S3101.400R.U.D Automatic Drug Recognition 
System 

U Automatic Drug Recognition dark color 
right arm UPGRADE  

S3101.400R.U.L Automatic Drug Recognition 
System 

U Automatic Drug Recognition light color 
right arm UPGRADE  

S3101.INST In-Service Training A Day of in-service training and installation 
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Warranty 
EXCLUSIVE ONE-YEAR LIMITED WARRANTY 

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or workmanship 
within one year from the date on which the product is shipped from Gaumard to the customer, Gaumard will, at 
Gaumard’s option, repair or replace the Gaumard product. 

This limited warranty covers all defects in material and workmanship in the Gaumard product, except: 

1. Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product; 

2. Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard 
product instructions, including failure to property clean the Gaumard product; and 

3. Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than Gaumard 
or a Gaumard representative. 

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the 
accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied warranties of 
merchantability, satisfactory quality, and fitness for a particular purpose. Except for the limited obligations 

specifically set forth in this one-year limited warranty, Gaumard will not be liable for any direct, indirect, special, 
incidental, or consequential damages, whether based on contract, tort, or any other legal theory regardless of 
whether Gaumard has been advised of the possibilities of such damages. Some jurisdictions do not allow disclaimers 
of implied warranties or the exclusion or limitation of consequential damages, so the above disclaimers and 
exclusions may not apply and the first purchaser may have other legal rights. 

This limited warranty applies only to the first purchaser of the product and is not transferable. Any 

subsequent purchasers or users of the product acquire the product “as is” and this limited warranty does not apply. 

This limited warranty applies only to the products manufactured and produced by Gaumard. This limited 

warranty does not apply to any products provided along with the Gaumard product that are manufactured by third-
parties. For example, third-party products such as computers (desktop, laptop, tablet, or handheld) and monitors 
(standard or touch-screen) are not covered by this limited warranty. Gaumard does not provide any warranty, express 
or implied, with respect to any third-party products. Defects in third-party products are covered exclusively by the 
warranty, if any, provided by the third-party. 

Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard. 

In the event of a perceived defect in material or workmanship of the Gaumard product, the first purchaser must: 

1. Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the Gaumard 
product to Gaumard without prior authorization. 

2. Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the original 
bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 Street, Miami, FL, 
33196-5691 USA. 

3. If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first 
purchaser will pay only the incidental expenses associated with the repair, including any shipping, handling, 
and related costs for sending the product to Gaumard and for sending the product back to the first 
purchaser. However, if the repairs are not covered by this limited warranty, then the first purchaser will be 
liable for all repair costs in addition to costs of shipping and handling. 

EXTENDED WARRANTY 

In addition to the standard one year of coverage, the following support plans are available: 

 Two-Year Extension (covers second and third years) 

Call for pricing (USA only) 
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Contact Us 
On the web  

www.Gaumard.com 

Technical Support  

support@gaumard.com 

Sales and Customer Service 

sales@gaumard.com 

Phone: 

Toll-free in the USA: (800) 882-6655 

Worldwide: 01 (305) 971-3790 

Fax: (305) 667-6085 

Before contacting Tech Support you must: 

 Have the simulator’s Serial Number 1.
(located in the left leg under the IM site) 

 Be next to the simulator if 2.
troubleshooting is needed 

Gaumard Scientific  

14700 SW 136 Street 

Miami, FL 33196-5691 USA 

Office hours: Monday-Friday, 8:30am - 
4:30pm EST (GMT-5, -4 Summer Time)  

Always dispose of this product and its 
components in compliance with local laws 
and regulations. 

 

The HAL simulation system is protected by 
US patent; other Patents Pending.  

Gaumard®, HAL®, GIGA™ are trademarks 
of Gaumard Scientific Company, Inc. 

© Gaumard Scientific Company, 2013. Made 
in U.S.A. All rights reserved. 
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